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Введение
Современную жизнь трудно представить без мультимедиа. Однако даже, несмотря на то, что мультимедийными технологиями ежедневно пользуются десятки тысяч людей, далеко не каждый из них имеет представление о том, что означает данное понятие.
В наши дни переоценить значение мультимедиа практически невозможно. Это связано с тем, что мультимедийные технологии с каждым днем все более активно приходят в наши дома. Однако необходимо добавить и то, что благодаря мультимедиа мы получаем огромную пользу. В качестве примера можно сказать о том, что современные мультимедийные технологии нашли свое широкое применение в обучающей сфере. Благодаря их использованию усвоение информации улучшилось в значительной степени.
Термин «мультимедиа» с английского можно перевести как «многие Среды» (от multi - много и media - среда).
В настоящее время мультимедиа-технологии являются бурно развивающейся областью информационных технологий. В этом направлении активно работает значительное число крупных и мелких фирм, технических университетов и студий (в частности IBM, Apple, Motorola, Philips, Sony, Intel и др.). Области использования чрезвычайно многообразны: интерактивные обучающие и информационные системы, САПР и др.
Благодаря развитию мультимедийных технологий появилась возможность объединять многокомпонентную среду (текст, звук, графику, видео, фото) в однородное цифровое представление и надежно и долго сохранять большие объемы информации. Информация гарантировано хранится не менее десяти лет. При этом переработка информации превращается из рутинных операций в творческие.
Основными характерными особенностями этих технологий являются:
· объединение многокомпонентной информационной среды (текста, звука, графики, фото, видео) в однородном цифровом представлении;
· обеспечение надежного (отсутствие искажений при копировании) и долговечного хранения (гарантийный срок хранения - десятки лет) больших объемов информации;
· простота переработки информации (от рутинных до творческих операций).
На сегодняшний день мы не можем не задумываться над тем, что ожидает наших учащихся. Известно, что будущее потребует от них огромного запаса знаний в области современных технологий. Сегодня уже 60% предложений о работе требуют минимальных компьютерных знаний, и этот процент будет возрастать. Но подготовка молодёжи к будущему заключается не только в плане «готовности работать». Учащиеся должны освоить новые жизненно необходимые навыки в связи с тем, что современные информационные технологии всё глубже проникают в нашу жизнь. Информационный депозитарий глобальной компьютерной сети Интернет настолько велик, что умение извлечь из такого большого объёма информации нужный кластер выходит на первый план.
Таким образом, использование мультимедиа технологий в учебном процессе не только целесообразно, но и позволяет достичь цели, которую ставит перед педагогами «Концепция модернизации Российского образования» - подготовка разносторонней развитой личности.
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[bookmark: _Toc432537179]Практическая работа №18. 
Создание и редактирование видеофайлов  в программе WindowsMovieMaker
Цель: научиться создавать и редактировать видеофайлы  в программе WindowsMovieMaker
Студент должен:
иметь практический опыт:
осуществления навигации по ресурсам, поиска, ввода и передачи данных с помощью технологий и сервисов Интернета (ПО2);
создания и обработки объектов мультимедиа (ПО3);
уметь:
создавать и редактировать объекты мультимедиа (У2);
знать:
назначение, разновидности и функциональные возможности программ для создания объектов мультимедиа (З2).

Программа Windows Movie Maker состоит из трех основных частей: области основных компонентов интерфейса, раскадровка или шкала времени и монитор предварительного просмотра.
Область, в которой создаются и монтируются проекты, отображается в двух видах: на раскадровке и на шкале времени. В процессе создания фильма можно переключаться между этими двумя видами.

Окно программы  Windows Movie Maker

[image: ]

Шкала времени
Шкала времени позволяет просматривать и изменять временные параметры клипов проекта. С помощью кнопок на шкале времени можно выполнять такие операции, как изменение вида проекта, увеличение или уменьшение деталей проекта, запись комментария или настройка уровня звука. Чтобы вырезать нежелательные части клипа, используйте маркеры монтажа, которые отображаются при выборе клипа. Проект определяют все клипы, отображаемые на шкале времени. 

[image: Добавляем в фотоклип текст]

Раскадровка
Раскадровка является видом по умолчанию в программе Windows Movie Maker. Раскадровку можно использовать для просмотра и изменения последовательности клипов проекта. Кроме того, в этом виде можно просмотреть все добавленные видеоэффекты и видеопереходы.

[image: Складываем из фотографий фотоклип]

Монитор предварительного просмотра (проигрыватель)
Монитор предварительного просмотра позволяет просматривать отдельные клипы или весь проект. При помощи монитора предварительного просмотра можно посмотреть проект перед публикацией его как фильма. Кнопки под монитором предварительного просмотра позволяют воспроизводить клип, приостанавливать воспроизведение или выполнять покадровое перемещение по клипу вперед или назад. Кнопка разделения позволяет разделить клип на две части по моменту, отображаемому на мониторе предварительного просмотра.
Можно сделать монитор предварительного просмотра больше или меньше, открыв в меню Вид подменю Размер окна при просмотре и выбрав размер. Также можно перетащить окно, чтобы сделать его больше или меньше.




 
Задания для выполнения работы:

Запустите Windows Movie Maker. Пуск – Программы - Windows Movie Maker 
Настройка интерфейса программы: проверьте меню Вид, активными являются (установлены флажки) пункты Панель инструментов, строка состояния, Панель задач.
Рассмотрите в левой части окна Панель задач. Определите, какие задачи Windows Movie Maker позволяет выполнить. 
Займемся монтажом видеофильма. На панели задач выберите пункт Импорт изображений. Выберите папку Рабочий стол-Видеофильм. Из тематической папки выберите все 12 графических файла, удерживая кнопку CTRL, и щелкните кнопку Импорт.
В центральной части окна на панели Сборник вы видите ваши выбранные графические файлы. Выделите их  и перетащите в нижнюю часть экрана в окна раскадровки.
Добавим эффекты рисунка. Для этого: Сервис – видеоэффекты. Просмотрите видеоэффекты и выберите любой понравившейся. Перенесите его на 1 кадр.  В правой части окна располагается плеер, нажмите кнопку → (Воспроизведение). Просмотрите эффект в плеере. Аналогично примените эффекты следующим кадрам видеофильма.
Между кадрами можно установить эффекты переходов. Для этого: Сервис – Видеопреход. В центральной части окна рассмотрите примеры видеопереходов. Выберите любой понравившейся, перенесите в нижнюю часть экрана на раскадровку и установите между двумя соседними кадрами. Аналогично установите видеопереходы для оставшихся кадров фильма.
Просмотрите результат монтажа в плеере. Есть возможность предварительного просмотра фильма во весь экран. Для этого: Вид – Во весь экран. 
Добавим титульный кадр и финальный кадр фильма. Для этого: На панели задач выбираем пункт Создание названий и титров . Выбираем пункт Добавить название в начале фильма. Вводим название фильма. Измените анимацию текста, его шрифт и цвет. Поэкспериментируйте, просматривая предварительный результат в окне плеера. Примените выбранные свойства, щелкнув по кнопке Готово, добавить название в фильм. 
Создайте титры в конце фильма. Выполняйте операции самостоятельно, аналогично п. 9.
Добавим звуковое сопровождение к фильму. На панели задач выбираем пункт Импорт звуки и музыки. Выбираем местонахождения звуковой информации. В нашем случае воспользуемся готовыми мелодиями, расположенными в той же тематической папке. Перенесите звуковой файл на раскадровку. Звуковой файл оказался длиннее фильма, необходимо отрезать лишнее, для этого: подведите указатель мыши к крайнему правому положению звуковой ленты и удерживая переместите до нужного места (указатель принимает вид двойной красной стрелки).
Сохраним созданный проект в идее фильма под  тем же названием, что и тематическая папка. Для этого: Сохранение на компьютере- в папке Мои видеозаписи. –Снова нажимаем кнопку "Далее" и ждем пока Movie Maker закончит создание видео-файла – Установите флажок в пункте – Воспроизвести фильм после нажатия кнопки готово. Нажмите кнопку Готово . Подождите немного, фильм сохраняется в видеоформате.
Контрольные вопросы:
1. Создание Flash-видео-презентации.
2. Открытие и закрытие изображения. Изменение размеров изображения. 
3. Особенности работы с многослойным изображением. 
4. Особенности работы с графическим планшетом. 
5. Чистка и восстановление деталей изображения с помощью инструмента «штамп». 
6. Приемы сканирования в Photoshop.
7. Понятие разрешающей способности и линеатуры растра. 
8. Звуковые карты.  Их классификация и рабочие характеристики.
9. Типы микрофонов. Основные характеристики микрофонов.



[bookmark: _Toc432537180]Практическая работа №19
Создание и редактирование видеофайлов   в программе Adobe Premiere Pro
Цель: научиться создавать и редактировать видеофайлы в программе Adobe Premiere Pro
Студент должен:
иметь практический опыт:
осуществления навигации по ресурсам, поиска, ввода и передачи данных с помощью технологий и сервисов Интернета (ПО2);
создания и обработки объектов мультимедиа (ПО3);
уметь:
создавать и редактировать объекты мультимедиа (У2);
знать:
назначение, разновидности и функциональные возможности программ для создания объектов мультимедиа (З2).

Общие сведения о программе
[bookmark: keyword1]Программа AdobePremiere позволяет производить нелинейный монтаж. Монтаж фильма в программе происходит в рамках проекта, который создает сама программа. Проекты имеют расширение *.prproj. В проекте хранятся ссылки на исходные файлы (их принято называть исходниками),на смонтированные фрагменты видео и звука, а также на применяемые к ним спецэффекты. Важно не забывать, что исходники в проекте представлены в виде ссылок на их имя и адрес на диске, поэтому при изменении одного из этих параметров AdobePremiere не сможет автоматически найти требуемый файл и попросит пользователя указать новый путь к нему. Особенно важно помнить об этом при переносе файла проекта с одного компьютера на другой. В соответствии с вашими целями можно создавать проекты с разными параметрами редактирования и качества видео. Смонтированный фильм перезаписывают в нужный вам универсальный видеоформат (выполняется так называемый экспорт файлов), после чего его можно просматривать вне рамок программы AdobePremiere.
Предустановки проекта
Приступая к монтажу фильма в программе AdobePremiere, важно заранее знать, где вы его потом собираетесь демонстрировать, так как от этого будут зависеть установки проекта. Различающиеся параметры настройки программы для импорта исходников, для процесса монтажа и для готового фильма могут существенно удлинить время работы над фильмом. Размер файла цифрового видео зависит от трех составляющих:
разрешение кадра в пикселях,
частота кадров (количество кадров в секунду),
глубина цвета (измеряется в битах).
Эти составляющие нужно учитывать, поскольку от них зависит размер готового файла. Если смонтированное видео предполагается размещать в Интернете, то размер файла должен быть как можно меньше. Если видео планируется в дальнейшем записывать на CD- или DVD-диски, то размер может быть средним. Наибольший размер имеют файлы, предназначенные для телевизионного просмотра.
Для телевизионных программ основные характеристики видео будут следующими:
разрешение от 720х480 пикселей и выше;
частота кадров в секунду — 25 (в системе PAL) или 30 (в системе NTSC);
глубина цвета — 32 бит.
Мультимедийные продукты, содержащие видео, имеют обычно такие характеристики:
разрешение 360х240 пикселей;
частота кадров — 15 (в секунду);
глубина цвета — 16 бит.
Для размещения видеофайлов в Интернете необходимо, чтобы они были небольшого размера, поэтому часто приходится жертвовать качеством картинки. Обычные параметры видеоизображений в Интернете таковы:
разрешение 160х120 или 180х120 пикселей;
частота кадров — 10 (в секунду);
глубина цвета 8 бит.
При запуске программы появится диалоговое окно, предлагающее вам выбрать работу с новым проектом (New project) или открыть уже существующий проект (Open project). Здесь же содержится ссылка на проекты, находившиеся недавно в работе (Recent project).
[image: http://fictionbook.ru/static/bookimages/04/07/31/04073145.bin.dir/h/i_001.png]
Рис. Окно приветствия
[bookmark: keyword17][bookmark: keyword18][bookmark: keyword19][bookmark: keyword20][bookmark: keyword21]Поскольку мы только начинаем работать в программе, выберем кнопку New project. Далее появится окно с так называемыми предустановками проекта. Вы можете выбрать установки, предложенные по умолчанию (Load Preset), а можете задать свои собственные (Custom Settings).
[bookmark: keyword22][bookmark: keyword23][bookmark: keyword24][bookmark: keyword25][bookmark: keyword26][bookmark: keyword27][bookmark: keyword28][bookmark: keyword29]Итак, рассмотрим уже существующие заготовки для предустановок проекта. Для работы на компьютере, в котором используются видеокарты SD–SDI и HD SDI, существуют свои готовые предустановки. Это предполагает работу с несжатым видео высокого качества. Такой тип видео имеет большое разрешение и предназначен для трансляции по телевизионным каналам. ПредустановкаDV-24p позволяет работать с видео, полученным с кинокамеры или имитирующим кинопленку. Для наших целей наилучшим образом подходит предустановка для работы с цифровым видео, ориентированная для показа в системе PAL. В каждой из предустановок есть возможность выбора стандартного (4:3) или широкого (16:9) экрана. Пока нам будет достаточно выбрать предлагаемый набор предустановок DV-PAL Standard 32 kHz.
[bookmark: keyword30][bookmark: keyword31][bookmark: keyword32][bookmark: keyword33][bookmark: keyword34]Рассмотрим подробнее пользовательские установки. Все их можно разделить на четыре группы (они расположены в левой части окна): общие установки (General), установки захвата видео (Capture), параметры рендеринга (Video rendering) и настройки для каждой вкладки (Sequence) окна монтажа.
[bookmark: image.2.2][image: Предустановки проекта]
Рис. Предустановки проекта

[bookmark: keyword35]В зависимости от выбранного вами режима редактирования (Editingmode) возможно изменение тех или иных параметров проекта. Допустим, изменять размер кадра можно только в режиме Desktop. Для всех остальных режимов этот параметр недоступен.
[bookmark: image.2.3][image: Настройка предустановок проекта пользователем]
Рис. Настройка предустановок проекта пользователем

[bookmark: keyword36][bookmark: keyword37][bookmark: keyword38][bookmark: keyword39]Параметр "Временная база" (Timebase) отражает количество кадров в интервале времени, равном 1 секунде. Значение временной базы зависит от выбранного режима видео: для формата NTSC — 29,97, для PAL и SECAM — 25, для режима DV24p — от 24 до 60.
[bookmark: keyword40]Скорость воспроизведения фильма определяется параметром "Частота кадров" (Framerate). Чтобы избежать потери данных, скорость воспроизведения должна совпадать по значению с временной базой.
"Размер кадра" (Framesize) определяет количество кадров по горизонтали (h) и по вертикали (v).
В списке "Поля" (Fields) важно выбрать следующие параметры в зависимости от ваших целей: если видео предназначено для просмотра на компьютере, то следует выбрать Nofields ("Нет полей"), если же предполагается просмотр на экране телевизора, то Lowerfieldfirst или Upperfieldfirst (это зависит от модели телевизора). Если статическое изображение на экране телевизора дрожит, попробуйте изменить параметр в списке "Поля".
[bookmark: keyword41][bookmark: keyword42]Во вкладке "Параметры редреринга" (Video rendering) важно обратить внимание на список "Компрессор" (Compressor). Компрессия (сжатие) используется для уменьшения размера видеофайла. Процесс сжатия может происходить в момент оцифровки видео, во время подготовки файла предварительного просмотра или во время экспорта видео.


Интерфейс программы.
[bookmark: image.2.4][image: Интерфейс программы Adobe Premiere]
Рис. Интерфейс программы AdobePremiere

В начале работы, до загрузки необходимых вам элементов будущего фильма, все окна пусты.
В программе существует три основных окна: "Проект" (Project), "Программа" (Program) и "Монтажный стол" (Timeline). Все остальные окна и вкладки являются дополнительными. Есть еще панели инструментов, которые мы будем рассматривать последовательно, по мере освоения нового материала.
Над окнами можно производить все привычные операции: перемещать, изменять размер. Окно может быть активным и неактивным.
Работать можно только в активном окне. Для этого нужно щелкнуть левой кнопкой мыши на нужное вам окно, и оно станет подсвечиваться оранжевым контуром.
Если на экране отсутствует нужное вам окно или палитра, то нужно обратиться к меню Window и выбрать пункт меню с названием необходимого окна.
Каждое окно внутри себя имеет собственное меню, настраивающее работу каждого окна в отдельности. Вход в меню находится в верхней правой части окна и обозначается круглой кнопкой с треугольником внутри.

Импорт файлов
[bookmark: keyword2][bookmark: keyword3][bookmark: keyword4]Для помещения исходных файлов в проект необходимо воспользоваться командой "Импорт" (Import) пункта меню "Файл" (File). Чтобы избежать возникновения возможных проблем, напомним, что лучше будет скопировать все исходники в одну папку и на протяжении всей работы над проектом не перемещать их в другое место на диске и не переименовывать. Такое требование связано с тем, что AdobePremiere не загружает в проект сами исходники, а хранит только ссылки на них. В противном случае объем проекта был бы чрезмерно большим.
[bookmark: image.3.1][image: Команда "Импорт"]
Рис. Команда "Импорт"

В диалоговом окне "Импорт" (Import) можно выбрать один или несколько необходимых файлов. Если требуется выбрать некую последовательность, то это можно сделать,удерживая клавишу Shift и выбирая левой кнопкой мыши первый и последний файлы последовательности. Если требуется выбрать насколько разрозненных файлов, то для этого удерживают нажатой клавишу Ctrl.
Можно загрузить в проект папку целиком. Для этого воспользуйтесь кнопкой ImportFolder (Импортировать папку).
После загрузки файлов и папок в проект они появятся в окне "Проект" (Project).
[bookmark: sect3]
Экспорт фильма
[bookmark: keyword5][bookmark: keyword6][bookmark: keyword7][bookmark: keyword8][bookmark: keyword9][bookmark: keyword10][bookmark: keyword11][bookmark: keyword12]Смонтированный фильм может быть записан на пленку, CD- или DVD-диск или просто перезаписан в один из общепринятых универсальных видеоформатов. Для этого необходимо войти в меню Файл (File), выбрать пункт меню "Экспорт" а "Фильм" (ExportаMovie). Чтобы команда "Экспорт" (Export) стала доступна, необходимо, чтобы окно "Монтажный стол" (Timeline) было активным.
Для просмотра параметров готового фильма нужно выбрать в диалоге "Экспорт" (Export) кнопку Settings ("Установки"), после чего откроется окно ExliortSettings ("Установки экспорта"). В закладках "Общие", "Видео" и "Аудио" можно выбрать нужные параметры итогового фильма.
Формат будущего файла. Поскольку мы работаем с цифровым видео, то выбираем формат DV
Какая область окна "Монтажный стол" (Timeline) включается в экспорт (вся последовательность (EntireClip) или только рабочая область (IntoOut)).
Режим воспроизведения видео (телевизионный формат (в нашем случае – PAL), размер кадра (FrameSize), количество кадров (FrameRate)).
[bookmark: keyword13][bookmark: keyword14][bookmark: keyword15][bookmark: keyword16]Очень удобно производить экспорт через специальную встроенную программу Adobe Media Encoder (меню "Файл" (File)). Выбирая окончательный формат фильма, здесь можно настраивать практически любые его характеристики.
Окончательныйформатфильма (MPEG1, MPEG2, Micromedia Flash Video, Quick Time, Real Media). Обратите внимание, что в зависимости от выбранного вами формата изменяются такие ключевые характеристики изображения, как размер кадра, частота кадров, частота звука, используемая компрессия. Общий обзор установок экспорта находится под заголовком Summary.
"Кодек" (VideoCodec) для сжатия фильма, который зависит от выбранного первоначально формата фильма. Использование данного инструмента позволит записать полуторачасовой фильм на один компакт-диск без существенной потери качества.
Битрейт (BitrateMode) – количество информации, выделяемой для записи звука и видео. Чем больше величина битрейта, тем лучше качество фильма и больше его размер. Предпочтительно использовать параметр VariableUnconstrained (Переменный битрейт). В этом случае величина битрейта изменяется в зависимости от качества картинки.
[bookmark: sect4]
Основные инструменты монтажа в окнах "Программа" (Program), "Источник" (Source) и "Монтажный стол" (Timeline)
Окно "Программа" (Program)
Служит для просмотра находящегося в монтаже или уже готового материала. Кадр, отображаемый в окне, соответствует положению курсора в окне "Монтажный стол" (Timeline).
[bookmark: ][image: http://www.intuit.ru/EDI/18_03_14_3/1395134682-6996/tutorial/544/objects/5/files/03_01.gif]

[bookmark: image.5.1][image: Окно "Программа"]

Рис. Окно "Программа"
Установка входящего маркера.Служит для маркировки начала фильма или какого-либо фрагмента.
Установка выходного маркера.Служит для маркировки окончания фильма или какого-либо фрагмента.
Установка ненумерованного маркера.Может служить для отметки необходимых фрагментов фильма. Обратите внимание, что все маркеры, установленные в окне "Программа" (Program), автоматически переносятся в окно "Монтажный стол" (Timeline). Если навести курсор мыши на значок ненумерованного маркера в окнах "Программа" (Program) или "Монтажный стол" (Timeline) и затем щелкнуть правой кнопкой мыши, появится выпадающее меню маркеров.
Переместить курсор к входному маркеру.Служит для быстрого перемещения к началу фильма или к фрагменту, отмеченному входным маркером.
[bookmark: image.5.2][image: Меню маркеров окна "Программа"]

Рис. Меню маркеров окна "Программа"

Переместить курсор к выходному маркеру.Служит для быстрого перемещения в конец фильма или фрагменту, отмеченному выходным маркером.
Проиграть клип от входящего до выходящего маркера.
Переход к предыдущей точке редактирования от текущей позиции курсора.
Переход к предыдущему кадру.
Начать воспроизведение фрагмента от входного маркера.Это действие запускается также нажатием клавиши "пробел". После начала воспроизведения эта же кнопка (или клавиша "пробел") повторным нажатием обеспечивает остановку воспроизведения.
Перейти к следующему кадру.
Переход к следующей точке редактирования от текущей позиции курсора.
Ползунковый регулятор, позволяющий перемещаться по фильму с разной скоростью.
Полоса протяжки.Служит для перемещения по всей длине клипа.
Циклическое воспроизведение фильма от начального до конечного маркера.
На миниатюре кадра появляются так называемые безопасные границы для действий и надписей. Все, что находится внутри этих границ, будет гарантированно отображаться на экране. Рамки безопасных границ предназначены только для удобства пользователя и не будут отображаться в итоговом фильме.
Нажав на маленький треугольник в нижнем правом углу кнопки, получите выпадающее меню для настройки изображения в окне "Программа" (Program). Верхняя часть окна предназначена для отображения параметров прозрачности, яркости и цветовой модели изображения. Средняя часть определяет качество видео, отображаемого в окне "Программа" (Program), - наивысшее, черновое и динамическое (изменяющееся в зависимости от характеристики видео). Параметр Playback Settings позволяет настроить параллельное с окном "Программа" (Program) отображение картинки на внешнем устройстве.
Удаление клипа из окна "Монтажный стол" (Timeline) без изменения общей длины всей последовательности.
Удаление клипа из окна "Монтажный стол" (Timeline) со сдвигом всей остальной последовательности влево.
Включает режим тримминга.Этот режим позволяет визуально произвести стыковку кадров двух находящихся рядом фрагментов.


Видео- и аудиопереходы

Понятие перехода
Переходом в программе AdobePremiere называется особый эффект, который применяется при смене одного изображения (или звукового фрагмента) на другой. До сегодняшнего урока мы монтировали клипы "в стык": то есть как только заканчивался один видеофрагмент, сразу начинался другой. Довольно часто можно увидеть, как одно изображение плавно переходит в другое либо смена картинки происходит за счет эффекта перелистывания страницы, или "шторок", или вытеснения и т. д. Программа AdobePremiere предлагает несколько десятков разных переходов. Вкладка окна, содержащего переходы, называется "Эффекты" (Effects). Переходы здесь представлены двумя типами: папка "Видеопереходы" (Video Transitions) и папка "Аудиопереходы" (AudioTransitions). Рассмотрим сначала переходы, предназначенные для монтажа видеофайлов. Для этого нужно выбрать список"Видеопереходы" (Video Transitions).
Видеопереходы
При нажатии на белый треугольник рядом с названием "Видеопереходы" (Video Transitions) появится список предлагаемых программой видеопереходов. Они разложены в папки по видам.
[bookmark: image.7.1][image: Папка видеопереходов]
Рис. Папка видеопереходов


Основные виды переходов.

3D Motion — создает пространственный эффект смены одного изображения другим. Например, вот так выглядит переход FlipOver:
	[bookmark: table_][image: http://www.intuit.ru/EDI/18_03_14_3/1395134682-6996/tutorial/544/objects/7/files/04_fksm.gif]

Первый фрагмент
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Начало перехода
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Конец перехода
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Второй фрагмент

	
	
	
	



Dissolve — группа переходов, обеспечивающих плавное растворение одного изображения и появление второго. Переход CrossDissolve будет выглядеть так:
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GPU Transitions — группа переходов, обеспечивающих переход от одного фрагмента к другому при помощи создания эффекта анимации. Рассмотрим эту группу на примере перехода Sphere:
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Iris — группа переходов, где на фоне первого клипа появляется некая врезка, через которую проступает изображение второго фрагмента. Например, так работает переход Iris Diamond:
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Map — группа эффектов, работающих с цветностью и яркостью двух фрагментов.

PagePeel — группа переходов, создающих эффект переворачивания страницы с одного фрагмента на другой. Эффект PagePeel:
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Slide — группа переходов, имитирующих смену слайдов. Эффект Push:
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SpecialEffects — группа эффектов, служащих для задания параметров наложения одного видеофрагмента на другой.

Stretch — группа эффектов, обеспечивающих переход за счет искажения картинки. Например, вот так работает переход Funnel:
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Wipe — группа переходов, создающих эффект вытеснения первого фрагмента вторым. Например, переход Pinwheel:
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	Первый фрагмент
	Переход
	Второй фрагмент



Zoom — группа эффектов, применяющих эффект масштабирования при смене фрагментов. Рассмотрим один из эффектов этой группы ZoomBoxes:
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Использование титров в фильме

Титры являются неотъемлемым элементом любого фильма. Они могут состоять из одного слова, фразы, графических объектов; быть статическими или динамическими, находиться в каком-либо одном месте экрана или перемещаться по нему. Титры представляют зрителю название фильма, команду, работающую над фильмом (режиссер, оператор, актеры, художники и так далее), служат пояснением происходящему на экране или его дополнением. Титры, появляющиеся в самом начале фильма, называются начальными, в конце - заключительными.
Программа AdobePremiere предоставляет широкие возможности для создания титров непосредственно в программе. Для этого существует специальный редактор титров. Для его вызова необходимо обратиться к пункту меню "Файл" (File), далее выбрать команду "Новый" (New) и нажать на слово "Титры" (Title). В появившемся диалоговом окне предлагается ввести название файла титров. Далее перед вами открывается окно редактора титров.

Редактор титров
Прежде чем приступить к созданию титров, необходимо учитывать несколько правил.
Соблюдать так называемую Безопасную область титров (TitleSafeArea). Эта область соответствует второй, внутренней рамке окна редактора титров. Желательно не выводить титры за пределы этой рамки, так как в противном случае часть изображения, выходящая за безопасные границы, может быть утеряна.
Помните, что цвета неодинаково отображаются на экране монитора и на экране телевизора.
Лучше не использовать шрифты с засечками в титрах, так как тонкие линии (засечки) могут нечетко отображаться на экране или мерцать.
При помещении титра на какое-либо изображение важно помнить, что надпись должна быть читаема. Для выделения текста титров часто используют тень и градиент (плавный переход одного цвета в другой).
Итак, рассмотрим основные области редактора титров.
Прежде чем приступать к созданию титров, необходимо решить, на каком фоне они будут располагаться (черный экран, заливка каким-либо цветом или изображение). Если титры будут располагаться поверх изображения, то сначала нужно поместить требуемый видеофрагмент или графический файл на дорожку окна монтажа (Timeline) и установить курсор в то место линейки времени, с которого предполагается демонстрация титров. Затем открыть редактор титров и приступить к их созданию
[bookmark: image.9.1][image: Окно Редактора титров]
Рис. Окно Редактора титров

Если титры идут поверх изображения, уже помещенного в окно "Монтажный стол" (Timeline), то в окне просмотра будет отображаться кадр, на котором в данный момент находится курсор окна монтажа (Timeline).
Основной панелью для создания титров является панель, расположенная по умолчанию в верхнем левом поле. Рассмотрим основные инструменты этой палитры.
Итак, титры, создаваемые при помощи редактора, могут быть нескольких видов:
Горизонтальные титры
Вертикальные титры
Статические титры
Титры, расположенные вдоль кривой
Бегущие титры (RollingTitle)
Динамические титры
Перемещающиеся титры (CrawlTitle)
Чтобы создать простые статические титры (горизонтальные или вертикальные), нужно выбрать один из инструментов основной панели (горизонтальный текст или вертикальный) и затем в области просмотра при помощи мыши нарисовать рамку для будущих титров. Затем выбираем стиль титров из библиотеки стилей, расположенной под областью просмотра. Если готовый стиль чем-то не устраивает, то можно внести дополнительные коррективы во внешний вид титров при помощи панели дополнительных настроек "Свойства титров" (Title Properties). Предварительно необходимо при помощи инструмента "Выбор" выделить титр, который нужно отредактировать. Все изменения, которые будут вами вноситься, будут сразу же отображаться в области просмотра. В данном случае рендеринг не нужен.
[bookmark: image.9.2][image: Палитра инструментов Редактора титров]
Рис. Палитра инструментов Редактора титров

Редактор титров позволяет создавать титры вдоль воображаемой кривой. Для этого сначала при помощи инструмента "Текст вдоль кривой" (или "Вертикальный текст вдоль кривой") нужно нарисовать линию, вдоль которой нужно будет разместить текст (при просмотре линия видна не будет), и затем ввести с клавиатуры текст.
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Горизонтальные титры
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Горизонтальные титры вдоль кривой с воображаемыми линиями
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Горизонтальные титры вдоль кривой на экране

	
	
	



Задания для выполнения практической работы

Задание 1.
Подготовить исходники, то есть сделать фоторепортаж на любую интересную вам тему. Это могут быть как собственные фотографии, так и подборка картинок из Интернета. Важно, чтобы картинки отражали некую общую идею ("Мой любимый исполнитель", "Моя улица", "Моя школа", "Летнее путешествие" и т. д.). Подобрать небольшой музыкальный отрывок, который будет сопровождать изображение.
Создать проект в программе AdobePremiere. При создании проекта нужно учитывать, что смонтированный фильм предполагается демонстрировать на компьютере.
Загрузить исходники в проект и отсмотреть их в окне предварительного просмотра.
Составить монтажный лист, расположив исходные файлы в соответствии с общим замыслом и правилами монтажа. Длительность одного статического изображения на экране — произвольная.
Переместить исходники в окно монтажа.
Провести рендеринг проекта и отсмотреть полученный результат в окне "Программа".
Если никаких изменений вносить не требуется, экспортировать фильм в формат Microsoft AVI, разрешением 360х240 пикселей.

Ход выполнения задания
Все исходные файлы и сам проект лучше помещать в одну папку, созданную специально под проект.
Изменить размер кадра можно во вкладке пользовательских настроек окна предустановок проекта. Свои настройки можно сохранить, нажав кнопку Save Preset, чтобы использовать их в дальнейшем.
Фотографии часто бывает полезно отсмотреть в виде миниатюр, чтобы точнее определить их логическую последовательность в фильме.
Вспомните про правила монтажа. Какие кадры лучше всего состыкуются между собой (важны цвет, направление движения в кадре, крупность плана)?
Для того чтобы статическое изображение в кадре не искажалось и отображалось полностью, необходимо выделить нужный файлна "Монтажном столе" (Timeline), нажать левую кнопку мыши и установить флажок у параметра Scale toframe size.
[bookmark: image.4.1][image: Выбранный исходник неполностью отображается в окне "Программа"]
Рис. Выбранный исходник неполностью отображается в окне "Программа"

[bookmark: image.4.2][image: Выбранный исходник полностью отображается в окне "Программа"]
Рис. Выбранный исходник полностью отображается в окне "Программа"

Не забывайте, что у ленты времени в верхней части окна "Монтажный стол" (Timeline) есть свой масштаб. Его можно изменить, воспользовавшись кнопками увеличения/уменьшения масштаба в левой нижней части окна.
Для видеоизображений и статических файлов предназначены дорожки Video, для звуковых файлов — дорожки Audio.

Задание 2.
Необходимо создать несколько файлов-исходников с разными типами титров.
1.Используя проект, подготовленный при выполнении практической работы № 3 ("Художественная галерея"), создайте для изображений, задействованных в данном проекте, информационный титр (название картины, памятника архитектуры, имя автора и т. д.). Результат упражнения сохраните в качестве отдельного проекта для последующей работы.
2.Ваш знакомый режиссер попросил вас создать начальные и заключительные титры к его уже готовому фильму. У режиссера было всего два требования:
чтобы титры были бегущие, начинались за пределами экрана и за его же пределами исчезали;
чтобы в титрах были упомянуты все люди, которые работали над фильмом. Попробуйте ему помочь. Заодно вспомните, кто обычно упоминается в титрах к фильму.
В данном случае можно ограничиться списком из 7-10 участников.
3. Попробуйте создать вот такой титр с надписью "Бесконечность" в форме математического значка:
[bookmark: image.10.1][image: Титр "Бесконечность"]
Рис. Титр "Бесконечность"

Ход выполнения задания
При выполнении упражнения № 1 особое внимание уделите тому, читается ли титр на фоне изображения.
При выполнении упражнения № 3 порядок действий следующий:
При помощи инструмента "Текст" нарисовать кривую требуемой формы.
Отредактировать ее при помощи инструментов "Перо", "Добавить/Удалить точки привязки".
Ввести текст с клавиатуры.
Отредактировать текст при помощи панели дополнительных настроек "Свойства титров" (TitleProperties).

Контрольные вопросы 
Что такое "исходник"?
Как импортировать файлы в проект? Можно ли для этого воспользоваться командой "Open" ("Открыть")?
Почему при импорте файлов в проект программа AdobePremiere сохраняет лишь ссылки на них, а не сами файлы?
Для чего используется команда "Экспорт"? Обязательно ли экспортировать готовый фильм?
Контрольные вопросы:
10. Создание Flash-видео-презентации.
11. Открытие и закрытие изображения. Изменение размеров изображения. 
12. Особенности работы с многослойным изображением. 
13. Особенности работы с графическим планшетом. 
14. Чистка и восстановление деталей изображения с помощью инструмента «штамп». 
15. Приемы сканирования в Photoshop.
16. Понятие разрешающей способности и линеатуры растра. 
17. Звуковые карты.  Их классификация и рабочие характеристики.
18. Типы микрофонов. Основные характеристики микрофонов.
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Рисование во Flash. Создание анимированных фильмов во  Flash

Цель: овладеть навыками практической работы с программой Macromedia Flash
Студент должен:
иметь практический опыт:
осуществления навигации по ресурсам, поиска, ввода и передачи данных с помощью технологий и сервисов Интернета (ПО2);
создания и обработки объектов мультимедиа (ПО3);
уметь:
создавать и редактировать объекты мультимедиа (У2);
знать:
назначение, разновидности и функциональные возможности программ для создания объектов мультимедиа (З2).

[bookmark: _Toc114975968]
Технология Flash основана на использовании векторной графики в формате Shockwave Flash (SWF). Macromedia Flash (просто Flash)  среди разработчиков Web-публикаций пользуется наибольшей популярностью. 
Составляющими Flash-технологии являются: 
         векторная графика; 
         поддержка нескольких видов анимации; 
         возможность создания интерактивных элементов интерфейса; 
         поддержка взаимодействия с импортируемыми графическими форматами (в том числе растровыми); 
         возможность включения синхронного звукового сопровождения; 
         обеспечение экспорта Flash-фильмов в формат HTML, а также в любой из графических форматов, используемых в Интернете; 
         возможность просмотра Flash-фильмов как в автономном режиме, так и посредством Web-броузера; 
         наличие инструментов визуальной разработки, избавляющих создателя Flash-фильмов от многих рутинных операций, а также от детального изучения технических аспектов реализации Flash-технологии. 
[bookmark: 2] 
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[bookmark: _Toc201146035]1. Рисование во Flash
 
1.1. Инструменты рисования 
Рисование выполняется с помощью инструментов, расположенных на панели Tools. Основными из них являются: 
Bine Tool (Линия) - позволяет рисовать прямые и ломаные линии, используемые в качестве контура объекта. 
Oval Tool (Овал) - предназначен для создания стандартных геометрических фигур: эллипсов и окружностей различного радиуса. 
Rectangle Tool (Прямоугольник) - предназначен для создания соответствующих геометрических фигур. 
Pen Tool (Перо) - позволяет рисовать прямые и сглаженные кривые линии с высокой точностью на основе механизма кривых Безье, для этого в процессе рисования Flash создает базовые точки (Anchor points) и затем строит по ним нарисованный сегмент. 
Pencil Tool (Карандаш) - предназначен для рисования произвольных линий, однако при соответствующей настройке параметров он выполняет «распознавание» нарисованных фигур и автоматическое их преобразование к стандартным геометрическим фигурам.
 Brush Tool (Кисть) - позволяет рисовать линии, напоминающие мазки кистью. Кисть имеет достаточно большое число дополнительных параметров.
Eraser Tool (Ластик) - это обычная для графических редакторов «стирательная резинка», по принципу действия и по набору дополнительных параметров она очень близка инструменту Brush Tool. 
Результаты использования любого из перечисленных инструментов могут быть впоследствии отменены или скорректированы с помощью инспектора свойств. 
 
1.2. Инструменты изменения формы линий и контуров фигур 
Пользователь имеет возможность изменять форму линий и контуры фигур, созданных с помощью инструментов Pen, Pencil, Brush, Line, Oval или Rectangle. Редактирование может выполняться инструментами Arrow, Free Transform и Subselection, либо средствами оптимизации кривых. Чтобы изменить форму линии или контур фигуры, можно перетащить на новую позицию любую точку линии, «зацепив» ее инструментом Arrow. 
 
1.3. Инструменты для работы с цветом 
Flash обеспечивает различные механизмы применения, создания и модификации цветовой палитры фильма и отдельных его элементов. 
Для работы с цветом во Flash предназначены следующие средства: 
         инструменты Ink Bottle Tool (Бутылка чернил), Paint Bucket Tool (Банка краски), Fill Transform (Трансформация заливки) и Dropper Tool (Пипетка), расположенные на панели Tools; 
         кнопки Stroke Color (Цвет контура), Fill Color (Цвет заливки), Default Colors (Цвета по умолчанию), No Color (Бесцветный) и Swap Colors (Поменять цвета), расположенные в поле Colors панели Tools; 
         панели Color Mixer (Смеситель цвета) и Color Swatches (Образцы цвета). 
 
Задание для самостоятельной работы
Нарисовать рисунок во Flash в соответствии с заданным вариантом из таблицы, используя инструменты рисования. 
 
	№ п/п
	Задание
	№  п/п
	Задание

	1
	Звездное небо
	16
	Ледовый каток

	2
	Озеро
	17
	Речной пляж

	3
	Оазис
	18
	Горный пейзаж

	4
	Лесная поляна
	19
	Водопад

	5
	Пустыня с барханами
	20
	Цветочная клумба

	6
	Футбольный стадион
	21
	Телевизор

	7
	Хоккейный корт
	22
	Кустарник

	8
	Морской пляж
	23
	Небоскреб

	9
	Городской квартал
	24
	Железная дорога

	10
	Огород
	25
	Цветок в горшке на подоконнике

	11
	Кухонный стол
	26
	Витрина хозяйственного магазина

	12
	Витрина продовольственного магазина
	27
	Цветок в горшке

	13
	Ствол дерева 
	28
	Офис

	14
	Палуба парохода
	29
	Сцена

	15
	Бассейн
	30
	Гараж


 
[bookmark: _Toc201146036]2. Создание анимированных фильмов во Flash
В зависимости от сюжета фильма и собственных художественных способностей, можно выбрать один из двух способов «оживления» персонажей фильма: 
         покадровую анимацию (Frame-by-frame, «кадр за кадром»), 
         автоматическую анимацию (tweened-анимацию).
Оба механизма могут использоваться совместно как в рамках одного фильма, так и применительно к одному объекту. Основной принцип анимации - каждому моменту времени - свой кадр. 
 
2.1. Покадровая анимация 
Для создания покадровой анимации требуется предварительно подготовить  каждый кадр фильма, учитывая плавность перехода от одного кадра к другому.  
Основным инструментом при создании покадровой анимации является панель временной диаграммы – позволяет создавать, удалять и перемещать кадры анимации, изменять режимы просмотра отдельных кадров и всей сцены. 
Процедура создания покадровой анимации  шара, который падает и разбивается на три части: 
1. Шар в исходном положении. 
2. Шар упал, но пока цел. 
3. От шара откололся первый кусочек. 
4. От шара откололся второй кусочек. 
5. На столе лежит нечто, в предыдущей жизни бывшее шариком. 
С учетом описанного сюжета, последовательность работы должна быть следующей: 
1. Создайте на столе четыре изображения, соответствующие указанным выше кадрам. 
2. Создайте новый файл фильма с «чистым» столом, щелкнув на кнопке New (Создать) основной панели инструментов Flash.
3. На временной диаграмме в ячейке первого кадра щелкните правой кнопкой мыши и в контекстном меню выберите команду Insert Keyframe (Вставить ключевой кадр).
4. Из окна, в котором создавались изображения шара, скопируйте первое изображение и поместите его где-нибудь в верхней части стола; при этом первый кадр на временной диаграмме будет помечен как ключевой (черной точкой). 
5. Щелкните правой кнопкой мыши в ячейке второго кадра и в контекстном меню выберите команду Insert Keyframe, при этом кадр будет сразу помечен как ключевой, поскольку для него наследуется изображение из предыдущего кадра. Воспользуйтесь им и переместите изображение шара в нижнюю часть стола.
6. Щелкните правой кнопкой мыши в ячейке третьего кадра и в контекстном меню вновь выберите команду Insert Keyframe. Новый кадр также будет помечен как ключевой, и для него сохранится предыдущее изображение. Его можно отредактировать или заменить нужным.
7. Создайте четвертый и пятый кадры, выбирая в контекстном меню команду Insert Keyframe и помещая на стол соответствующее изображение. 
Чтобы воспроизвести фильм, достаточно просто нажать клавишу <Enter> (альтернативный вариант - выбрать в меню Control команду Play - «воспроизвести»). 
 
2.2. Автоматическая анимация движения объекта 
Flash может создавать два типа tweened-анимации: 
- анимацию движения (motion tweening); 
- анимацию трансформирования объекта (shape tweening). 
Создавать анимацию движения можно, используя один из двух методов: 
         с помощью панели инспектора свойств кадра; 
         с помощью команды Create Motion Tween (Создать анимацию движения). 
Для описания обоих вариантов воспользуемся простейшим примером: предположим, что требуется «перекатить» шарик через стол слева направо. 
1. Убедитесь, что панель инспектора свойств присутствует на экране. Если она закрыта, выберите в меню Window основного окна пункт Properties. 
2. Включите инструмент Oval и нарисуйте шарик в левой части стола. 
3. Включите инструмент Arrow, выберите шарик и сгруппируйте (объедините в одно целое) контур и заливку шара с помощью команды Group, входящей в меню Modify основного окна Flash. Щелкните правой кнопкой мыши в ячейке того кадра на временной диаграмме, который вы хотите сделать последним кадром анимации (например, 10-й), и в контекстном меню выберите команду Insert Keyframe (Вставить ключевой кадр). В результате промежуток между первым и последним ключевыми кадрами будет заполнен одноцветными (светло-серыми) ячейками простых кадров. 
4. Перетащите шар на новую позицию в правой части стола. 
5. Щелкните левой кнопкой мыши в ячейке первого ключевого кадра, что приведет к одновременному выполнению двух действий: изображение шарика переместится на исходную позицию и изменится формат панели инспектора свойств, на которой будут представлены параметры выбранного (первого) кадра. 
6. В панели инспектора свойств выберите в раскрывающемся списке Tween пункт Motion. При этом формат панели изменится, и на ней появятся элементы интерфейса, позволяющие установить параметры анимации. 
Если на панели временной диаграммы вместо стрелки появилась пунктирная линия, значит, задание выполнено неверно. 
Для анимации движения шарика с помощью команды Create Motion Tween требуется выполнить следующие действия (считаем, что шарик в первом кадре уже присутствует): 
1. Щелкните правой кнопкой в ячейке первого кадра и в контекстном меню выберите команду Create Motion Tween (Создать анимацию движения). При этом изображение шара будет автоматически преобразовано в графический символ с именем tweenl (визуальным признаком преобразования служит появление точки привязки в центре шара и выделяющей рамки). 
2. Щелкните правой кнопкой в ячейке кадра, который вы хотите сделать последним в анимационной последовательности (например, 10-й), и в контекстном меню выберите команду Insert Frame (Вставить кадр). В результате между первым и последним кадрами появится пунктирная линия. 
3. Переместите шар на новую позицию (в правую часть стола), в результате последний кадр анимации будет автоматически преобразован в ключевой, а пунктирная линия будет заменена линией со стрелкой. 
Создание анимации на этом завершено. 
 
2.3. Автоматическая анимация трансформации объекта 
Используя анимацию трансформации, можно создавать эффект плавного «перетекания» объекта из одной формы в другую с помощью узловых точек формы (shape hints). Узловые точки используются для идентификации тех точек исходной формы, взаимное расположение которых требуется сохранить. Наиболее характерный пример использования узловых точек - анимация мимики лица, при которой некоторые его части (глаза, в частности) не должны участвовать в трансформации. Для расстановки узловых точек требуется выполнить следующие действия: 
1. Щелкните левой кнопкой мыши в ячейке кадра, соответствующего исходному изображению. 
2. В меню Modify выберите каскадное меню Shape, а в нем - команду Add Shape Hint (Добавить узловую точку). В результате на изображении появится заготовка первой узловой точки - кружок красного цвета с буквой а. 
3. Переместите его мышью на ту точку изображения, которую нужно пометить как узловую. 
4. Щелкните левой кнопкой мыши в ячейке кадра, соответствующего результирующему изображению. На столе будет присутствовать красный кружок с той же буквой, что и в исходном кадре. 
5. Переместите кружок в точку изображения, которая должна быть отмечена в исходном кадре; после перемещения кружок станет зеленым. 
6. Вернитесь на первый кадр анимированной последовательности и убедитесь, что цвет узловой точки изменился на желтый. 
Расстановка узловых точек возможна только после создания tweened-анимации трансформации. Расстановку узловых точек следует выполнять с помощью инструмента Arrow при включенном модификаторе Snap to Objects. 
После расстановки узловых точек целесообразно провести тестовый запуск фильма и при необходимости скорректировать расстановку точек. Чтобы изменить положение узловой точки, достаточно просто перетащить ее на новое место. 
Задание для самостоятельной работы
[bookmark: _Toc201146037]Создать мультипликацию в соответствии с заданием из таблицы, используя при этом покадровую анимацию, автоматическую анимацию движения и автоматическую анимацию трансформации объекта.
 
	№ п/п
	Задание
	№ п/п
	Задание

	1
	Летящую ракету
	16
	Ледовый каток

	2
	Плавающую рыбу
	17
	Прыгающий мяч

	3
	Солнце, движущееся по горизонту
	18
	Снежную лавину

	4
	Пролетающий самолет
	19
	Бегущего таракана

	5
	Падающий и раскалывающийся шар
	20
	Растущие цветы

	6
	Мяч, улетающий по кривой траектории
	21
	Летящую и взрывающуюся бомбу

	7
	Шайбу, движущуюся по кривой траектории
	22
	Пролетающий вертолет

	8
	Плавающую рыбу 
	23
	Строящийся небоскреб

	9
	Движущуюся машину 
	24
	Падающий и сминающийся шар 

	10
	Растущую капусту
	25
	Салют

	11
	Падающее со стола яйцо
	26
	Движущейся легковой автомобиль

	12
	Едущий автобус
	27
	Улетающий воздушный шар

	13
	Растущее, а потом падающее яблоко 
	28
	Бегущего ежика

	14
	Качающийся колокол
	29
	Пикирующий дельтаплан

	15
	Движущийся поезд
	30
	Движущийся грузовой автомобиль


 
 
[bookmark: _Toc201146038]3. Работа со слоями
Слой (Layer) - это часть сцены фильма, для которой могут быть установлены некоторые индивидуальные атрибуты. Каждый слой может содержать произвольное число различных объектов, учитывая ограничения на создание tweened-анимации. Применение механизма слоев позволяет автономно работать с различными объектами, подлежащими включению в фильм, и за счет этого создавать сложные многоплановые сцены. Например, один из слоев может использоваться в качестве фона, на котором разворачиваются события фильма, другой - анимированные объекты, а третий - элементы звукового сопровождения фильма. 
 
3.1. Свойства слоев 
В обычном режиме все слои абсолютно прозрачны. Объект, находящийся на верхнем слое, заслоняет объекты, находящиеся в той же позиции на нижних слоях. Всегда возможно изменить порядок расположения слоев, а также редактировать объекты одного слоя независимо от элементов других слоев. Однако при необходимости можно выбрать одновременно объекты из разных слоев и работать с ними как с единым целым. Число создаваемых слоев ограничено только объемом оперативной памяти компьютера, и не влияет на размер файла публикуемого фильма. 
Для удобства работы со слоями во Flash реализована возможность хранения каждого набора взаимосвязанных слоев в отдельной папке слоев (Layer Folder). 
Создание и удаление слоев. 
Для создания нового слоя требуется выполнить одно из следующих действий: 
         в списке слоев на панели временной диаграммы щелкнуть правой кнопкой мыши на том слое, над которым надо поместить новый и в контекстном меню выбрать команду Insert Layer (Вставить слой); 
         в списке слоев на панели временной диаграммы выбрать слой, над которым требуется поместить новый, щелкнув на нем левой кнопкой мыши; щелкнуть кнопку Insert Layer, расположенную ниже списка слоев. 
Для удаления слоя следует выполнить одно из следующих действий: 
         в списке слоев на панели временной диаграммы щелкнуть правой кнопкой мыши на том слое, который надо удалить и в контекстном меню выбрать команду Delete Layer (Удалить слой); 
         в списке слоев на панели временной диаграммы выбрать удаляемый слой, щелкнув на нем левой кнопкой мыши и щелкнуть кнопку Delete Layer. 
После удаления слоя активным становится слой, расположенный под ним. Операции создания и удаления слоя можно отменить (как и многие другие), щелкнув на кнопке Undo (Отмена). 
Создание и удаление папок слоев. Для создания папки слоев требуется выполнить: 
         в списке слоев на панели временной диаграммы щелкнуть правой кнопкой мыши на любом слое и в контекстном меню выбрать команду Insert Folder; 
         в списке слоев на панели временной диаграммы выбрать любой слой, щелкнув на нем левой кнопкой мыши и щелкнуть кнопку Insert Layer Folder. 
 
Задание для самостоятельной работы
[bookmark: _Toc201146039]Работа со слоями. 
 
[bookmark: _Toc201146040]4. Основы работы с текстом 
В любой Flash-фильм может быть добавлен текст. Может быть установлен размер, шрифт, стиль, интервал, цвет и способ выравнивания. Шрифт можно трансформировать - поворачивать, масштабировать, наклонять, сохраняя возможность редактирования его символов. На основе фрагмента текста может быть создана гиперссылка. Flash-фильм может содержать динамические текстовые поля, а также поля, редактируемые пользователем. Во Flash можно создавать прокручиваемые многострочные текстовые области. Текст может быть конвертирован в графический объект, и тогда с его символами разрешается работать как с отдельными графическими фигурами. 
 
4.1. Создание и редактирование текста 
Чтобы добавить текстовое поле во Flash-фильм, следует выполнить следующие действия: 
1. Включить инструмент Text Tool на панели Tools. 
2. Щелкнуть мышью в той позиции на столе, куда требуется поместить текстовое поле. В результате в этой позиции появится текстовый курсор, окруженный выделяющей рамкой. 
3. Набрать текст. 
 
4.2. Редактируемый текст 
Редактируемый текст (Input Text) - текстовое поле, предназначенное для ввода и редактирования текста читателем Web-страницы. Например, запрос к базе данных, расположенной на сервере, или название сцены фильма, на которую хотел бы перейти посетитель сайта. 
Задание для самостоятельной работы
[bookmark: _Toc201146041]Используя разнообразные эффекты разработать и создать к фильму название и титры.
 
[bookmark: _Toc201146042]5. Создание и редактирование символов 
Символ - это объект (элемент фильма), который включен в библиотеку фильма и может быть неоднократно использован в этом же или в другом фильме. 
Экземпляр символа - это его копия, помещенная на стол или включенная в состав другого символа. Экземпляры могут достаточно сильно отличаться от символа-оригинала цветом, размером и даже типом. При этом вносимые в экземпляр изменения не влияют на оригинал. 
 
5.1. Типы символов 
Во Flash существует три основных типа символов: графические, кнопки и клипы. 
Графический символ (graphic symbol) используется в фильме в качестве статического или анимированного изображения. Его поведение описывается с помощью временной диаграммы основного фильма. 
Символ-кнопка (button symbol) предназначен для включения в фильм интерактивных кнопок, реагирующих на действия пользователя и управляющих воспроизведением фильма. С этой целью символу-кнопке могут быть назначены события (events), на которые она должна реагировать, и действия (Actions), которые инициализируются этими событиями. 
Символ-клип (movie clip symbol) служит для включения в библиотеку фильма повторно используемых анимаций. Каждый клип имеет свою собственную временную диаграмму, которая воспроизводится независимо от временной диаграммы основного фильма. Клип может содержать собственные интерактивные элементы управления, а также клипы более низкого уровня вложенности. 
 
5.2. Создание символов 
Символы могут создаваться двумя альтернативными способами: либо сначала создается некоторый объект, который затем преобразуется в символ, либо создается «пустая» заготовка символа, которая наполняется соответствующим содержимым. 
Преобразование в символ существующего объекта: 
1. Выбрать на столе объект (объекты), подлежащие преобразованию в символ. 
2. В меню Insert (Вставить) выбрать команду Convert to Symbol... (Преобразовать в символ). 
3. В открывшемся диалоговом окне Convert to Symbol указать параметры символа. 
4. Щелкнуть кнопку ОК. 
Создание нового символа. Чтобы создать новый пустой символ в начале убедитесь, что на столе отсутствуют выбранные объекты, и затем выполните одно из следующих действий: 
         в меню Insert выберите команду New Symbol; 
         в нижнем левом углу окна библиотеки (если оно открыто) щелкните кнопку New Symbol; 
         выберите команду с тем же именем из раскрывающегося меню окна библиотеки. 
В открывшемся диалоговом окне Symbol Properties  укажите имя и тип символа. При создании нового пустого символа Flash автоматически переходит в режим редактирования символа. 
Создание кнопок. Для создания символа-кнопки необходимо выбрать соответствующий вариант в диалоговом окне Symbol Properties, Flash видоизменяет панель временной диаграммы. Дело в том, что кнопка во Flash представляет собой 4-кадровую анимацию, в которой первые три кадра соответствуют определенному состоянию кнопки: отжата (Up), находится под указателем (Over) или нажата (Down). Четвертый кадр (Hit) предназначен для описания активной области кнопки. Активная область — это пространство, щелчок внутри которого воспринимается Flash как щелчок на кнопке. 
Создание клипов. Чтобы создать новый клип, необходимо: 
1. В меню Insert выбрать команду New Symbol. 
2. В диалоговом окне Symbol Properties ввести имя символа и установить переключатель Behavior в положение Movie Clip. 
3. Поместить на стол или нарисовать изображение, представляющее вид объекта в первом кадре клипа. При этом первый кадр временной диаграммы клипа автоматически становится ключевым. 
4. Любым из наиболее подходящих способов создайте анимацию. 
5. Для выхода из режима создания клипа следует щелкнуть в панели инструментов рабочей области на кнопке со стрелкой (слева от имени сцены) или непосредственно на имени сцены. 
Задание для самостоятельной работы
[bookmark: _Toc201146044] 6. Создание интерактивных фильмов 
Интерактивность Flash-фильма обеспечивается за счет включения в него так называемых сценариев, которые представляют собой набор инструкций на языке ActionScript. Каждая инструкция инициируется при наступлении определенного связанного с ней события. Объекты могут содержать данные или их графическое представление в виде символа определенного типа. 
6.1. Общие сведения об ActionScript 
ActionScript позволяет создавать сценарий для клипа, кнопки или кадра. Каждый такой сценарий  жестко связан с соответствующим элементом фильма. При публикации фильма текст сценария экспортируется в SWF-файл. Тем не менее, при желании можно сохранить его в отдельном файле с расширением .as, чтобы впоследствии использовать в каком-либо другом фильме. Из сценария можно обратиться к любому другому объекту фильма (из числа кнопок, клипов и кадров) и даже к другому фильму или какому-либо внешнему сетевому ресурсу. 
Контекст выполнения сценария. Контекст выполнения сценария определяет доступность и относительные адреса объектов и других программных величин (переменных), используемых в сценарии. Необходимость учитывать контекст появляется в том случае, если в сценарии используется несколько объектов или переменных с одинаковыми именами. 
С каждой временной диаграммой связан специальный параметр - уровень диаграммы (он обозначается с помощью ключевого слова _ level), который определяет ее положение относительно других временных диаграмм, загруженных в Flash-плеер. По умолчанию временная диаграмма основного фильма имеет нулевой уровень. 
Область действия переменных в Flash-фильме распространяется сверху вниз: имя переменной, созданной в сценарии временной диаграммы основного фильма, «видно» в сценарии следующего уровня, если в нем нет своей переменной с таким же именем. 
Кроме того, внутри программного блока сценария, ограниченного фигурными скобками, могут объявляться локальные переменные, которые «видны» только в пределах этого блока. 
Для управления областью видимости переменных в ActionScript используется понятие «путь назначения» - target path. Путь назначения позволяет указать принадлежность объекта или переменной конкретной временной диаграмме, загруженной в Flash-плеер. 
Чтобы правильно записать путь назначения, необходимо учитывать объектную модель ActionScript и взаимное положение временных диаграмм. 
Возможны два варианта указания пути назначения: абсолютный и относительный. 
Абсолютный путь вычисляется, как правило, на основе уровня временной диаграммы (как в приведенном выше примере). Указав в качестве отправной точки уровень диаграммы, вы можете быть уверены, что Flash-плеер правильно отыщет адресата, даже после того, как вы переместите фрагмент сценария, из которого выполнено обращение. 
Относительный путь вычисляется с учетом положения той диаграммы, из которой выполняется обращение. 
Итак, при создании сценариев на ActionScript возможно использование трех типов переменных, различающихся областью видимости: 
         глобальные (Global variables), которые доступны в сценарии любой временной диаграммы; 
         переменные временной диаграммы (Timeline variables), которые доступны из любой временной диаграммы при условии, что для обращения к ним используется путь назначения (target path); 
         локальные (Local variables), которые «видны» только в пределах того программного блока, в котором они объявлены. 
 
6.2. Создание сценария для кнопки 
Кнопка является наиболее удобным и простым средством взаимодействия пользователя с Flash-фильмом. Кнопке может быть назначено любое из действий, входящих в раздел Actions. Кроме того, назначив кнопке несколько управляющих событий и сопоставив каждому из них определенное действие (или сценарий), можно превратить одну кнопку в целый пульт управления фильмом. 
Управление воспроизведением фильма. Простейшими командами управления фильмом являются запуск и прерывание его воспроизведения. Эти команды реализуются с помощью предопределенных действий Play и Stop. В качестве кнопок используем экземпляры символов  общей библиотеки Buttons. Для включения в фильм интерактивных кнопок необходимо выполнить следующие действия: 
1. Добавьте в фильм новый слой, который будет использоваться в качестве дополнительного фона. Именно в фоновый слой следует добавить кнопки, чтобы они присутствовали на сцене на всем протяжении фильма. 
2. Щелкните мышью в ячейке первого ключевого кадра в «кнопочном» слое.
3. Перетащите поочередно из окна библиотеки на стол две кнопки, которые вы решили использовать в фильме. 
4. Выберите первую из кнопок, с помощью которой фильм должен приостанавливаться.
5. С помощью инспектора свойств кнопки откройте панель Actions и щелкните в списке Actions Toolbox на значке раздела Actions.
6. Откройте подраздел Movie Control, отыщите в нем действие Stop и дважды щелкните на нем мышью. В результате в окне сценария появится текст сценария, содержащий обработчик onfrelease. Он обеспечивает инициализацию действия stop() при наступлении события release. Пустые скобки после имени процедуры означают, что данная процедура используется без параметров, соответствующее сообщение выводится и в окне параметров.
7. Не закрывая панель Actions, выберите на столе вторую кнопку и назначьте ей действие play, повторив описанную выше процедуру. 
В отличие от обычной анимации, протестировать многие сценарии в режиме редактирования невозможно. Чтобы проверить, как работают созданные кнопки, следует выбрать в меню Control команду Test Movie или Test Scene. В результате фильм будет экспортирован в формат SWF и затем воспроизведен с помощью Flash-плеера. Чтобы вернуться в режим редактирования, достаточно просто закрыть окно плеера. 
 
6.3. Создание сценария для кадра 
Связав сценарий с некоторым ключевым кадром фильма, можно обеспечить автоматическую инициализацию тех или иных действий при достижении считывающей головкой этого кадра. Для этого необходимо: 
1. Щелкнуть правой кнопкой мыши в ячейке кадра и в контекстном меню выбрать команду Actions (если выбранный кадр не является ключевым, то действие будет назначено предшествующему ключевому кадру). 
2. В списке Actions Toolbox открыть раздел Actions, а в нем - требуемый подраздел. 
3. Дважды щелкнуть мышкой на действии, которое требуется назначить кадру. При этом в окно сценария будет помещена соответствующая конструкция на языке ActionScript. 
 
6.4. Создание сценария для клипа 
Как было отмечено в начале данной главы, клип, как и кнопка, может «реагировать» на те или иные события. Поэтому в большинстве случаев основу сценария для клипа составляет перечень обработчиков, описывающих реакцию клипа на те или иные события. 
Чтобы связать с клипом сценарий, необходимо: 
1. Щелкнуть правой кнопкой на клипе, которому вы хотите назначить действие. 
2. В контекстном меню выбрать команду Actions. 
3. В разделе Actions выбрать требуемое действие и перенести его в окно сценария. 
4. В поле параметров ввести требуемые значения. 
5. В окне сценария щелкнуть на строке с обработчиком onClipEvent. При этом в поле параметров появится перечень допустимых типов событий, которые могут инициализировать действие. 
     Выберите тип события, при наступлении которого введенные данные должны быть переданы на сервер. 
 
6.5. Компоненты Flash
В состав Flash включены семь типов компонентов: 
         CheckBox - флажок; 
         ComboBox - комбинированный список; 
         ListBox - список; 
         PushButton - кнопка; 
         RadioButton — переключатель; 
         ScrollBar — полоса прокрутки; 
         ScrollPane - окно. 
На ActionScript компоненты представляют собой подкласс объектов MovieClip, для которого предусмотрены специальные параметры и некоторые дополнительные методы. Параметры компонентов могут устанавливаться как во время разработки фильма, так и во время его воспроизведения, с помощью сценария. Методы, применимые к компонентам, собраны в специальном разделе списка Action Toolbox, который называется Flash UI Components. 
Вставку компонентов в фильм удобнее всего выполнять с помощью специальной панели Components. Для установки исходных параметров экземпляра компонента, включенного в фильм, целесообразно воспользоваться инспектором свойств. 
 
6.6. Озвучивание фильма 
Озвучивание фильма не связано непосредственно с обеспечением его интерактивности, однако чаще всего звуковое сопровождение делают управляемым со стороны посетителя сайта. 
Flash поддерживает несколько способов подключения звукового сопровождения. Можно использовать либо непрерывное звуковое сопровождение, не зависящее от временной диаграммы фильма, либо синхронизировать анимацию и звуковую дорожку. Разрешается назначать звуки кнопкам, кадрам и клипам. Добавленные в фильм звуки помещаются в библиотеку фильма наряду с растровыми изображениями и другими символами. 
Flash не располагает средствами создания звуков, но позволяет импортировать звуковые файлы в различных форматах (в том числе WAV и МРЗ) и затем корректировать параметры звука в соответствии с требованиями фильма. 
Чтобы добавить звук к фильму, необходимо выполнить следующие действия: 
1. Импортируйте в фильм один или несколько звуковых файлов. Для этого в меню File выберите команду Import, а с помощью стандартного окна Windows - требуемый файл. В результате содержимое файла будет автоматически добавлено в библиотеку фильма в качестве специального символа. 
2. Добавьте во временную диаграмму фильма новый слой, который будет использоваться в качестве звукового (использование отдельного звукового слоя облегчает тестирование и модификацию фильма). Разрешается создавать несколько звуковых слоев, и каждый из них будет работать подобно отдельному звуковому каналу. При воспроизведении фильма звуки на разных слоях, совпадающие во времени, воспроизводятся одновременно. 
3. Выберите в звуковом слое кадр, с которого вы хотите начать воспроизведение звука. Если данный кадр не является ключевым, выполните для него команду Insert -> Keyframe. 
4. Щелкните в ячейке первого озвучиваемого кадра и в панели инспектора свойств выберите в раскрывающемся списке Sound (Звук) требуемый звуковой символ. На панели появятся (или станут доступны) элементы управления, используемые для установки параметров звука, а также его исходные параметры: ширина полосы частот, моно/стерео, разрядность, длительность, занимаемый объем памяти.
5. Если это требуется, с помощью указанных элементов интерфейса скорректируйте параметры звука.
6. В раскрывающемся списке Sync выберите способ синхронизации звука.
7. Установите длительность звучания. Она определяется как число повторений звука, это число следует ввести в поле Loops (Циклы). Непосредственно после выбора в списке Sound одного из звуковых символов его амплитудная характеристика отображается на временной диаграмме . 
Изображение звука на временной диаграмме масштабируется в соответствии с установленной частотой кадров фильма. 
Можно связывать звуки с различными состояниями символа кнопки. Поскольку звуки сохраняются вместе с символом кнопки, они будут работать для всех ее экземпляров. 
Чтобы добавить звук кнопке, выполните следующие действия: 
1. Выберите символ кнопки в окне библиотеки и перетащите его на стол. 
2. На временной диаграмме кнопки добавьте звуковой слой. 
3. В этом слое создайте ключевой кадр, соответствующий тому состоянию кнопки, которое вы хотите озвучить. 
4. Щелкните правой кнопкой мыши в созданном ключевом кадре и с помощью элементов управления, имеющихся на панели инспектора свойств кадра, установите параметры звука. 
Для озвучивания других состояний кнопки необходимо повторить процедуру. 

2  Содержание практического задания
Теоретическая часть.

Мы создадим простой анимационный фильм, который можно будет использовать, допустим, в качестве заставки перед открытием главной страницы любого web-сайта, который будет демонстрировать открывающиеся возможности программы Macromedia Flash. Мы  будем работать над созданием фильма в версии 5.0. 
Во время создания анимационного фильма, для демонстрации различных видов анимации, мы организовали движение спутника вокруг планеты по эллиптической орбите и вращение самой планеты вокруг своей оси. Выполнение этой лабораторной работы - создание  маленького ролика мы решили описать подробно по шагам для полного понимания и возможности  повторить это любому, кто заинтересуется программой Flash и работе в ней. 
Для выполнения практической работы советуем загрузить программу  Macromedia Flash версии 5.0. 

[bookmark: 1._НАСТРОЙКА_ПАРАМЕТРОВ]2.1 Настройка параметров  фильма
Запустив Macromedia Flash, в меню File -> New создаем новый файл,  будущий Flash-ролик, которому даем название Спутник, что будет соответствовать цели нашего ролика.
 	Перед началом создания ролика, необходимо выставить нужные настройки фильма: 
1. Frame Rate –это частота кадров до 25fps, для сложной графики необходимо уменьшать частоту кадров до 8fps.
2. Dimensions –здесь указывается ширина (width) и высота (height) кадра в  пикселях, по умолчанию это значение равно 550?400, именно таким будет размер кадров фильма в браузере.
3. Match –здесь так же можно указать размеры кадра при помощи кнопок Printer и Contents. Чтобы узнать размеры кадра по размеру изображения в этом кадре, следует нажать кнопку Contents(содержимое). Если же надо сделать размер кадра соответственно параметрам печати нужно нажать кнопку Printer(печать).в секунду, для большинства  компьютеров, с учётом скорости загрузки с web-сайта, оптимальным  значением, принятым по умолчанию  является 12fps. Если же фильм простой и он будет просматриваться на очень быстром компьютере, то это значение можно увеличить.
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4. Background color – цвет фона кадров, по умолчанию это белый. 
5. Ruler units –единицы измерения линейки, которые отображают размеры кадра на сцене. Выбираются из списка те единицы, которые нам нужны. По умолчанию линейки выключены, а включить их можно при помощи команды меню View->Rulers.
Для применения выставленных параметров, нужно нажать кнопку Save Default. 
[bookmark: 2._СИМВОЛЫ_И_РАБОТА_С]
2.2 Символы и работа с ними 
Символы - одно из ключевых понятий во Flash. Символом может быть, как простейшая геометрия или их объединение, так и целая анимация (movie). Это позволяет использовать символы, как мощный механизм создания абстракций во Flash. 
Например, можно сделать символы - колесо, корпус, стекла, антенны. Потом все это объединить в символ - автомобиль. А затем создать сцену, на которой этот автомобиль будет ехать. Другой пример. Допустим, нам нужно нарисовать падающий снег. Я создаём символ снежинки, создаём символ, содержащий несколько анимирующихся снежинок, далее создаём символ в виде столбика падающих снежинок, затем размножаем этот столбик - и получаем падающий анимирующийся снег на всю сцену. 
Символы добавляют гибкости нашей сцене. В случае с автомобилем я можем сделать колесо анимированным символом, так, чтобы ощущалось вращение. Можем сделать дверь кнопкой, чтобы при клике мышкой она открывалась. Смысл в том, что в любой момент я можем изменить содержание и вид символа, что существенно сокращает затраты на модификацию Flash сцен. 
Существует три вида символов: анимация (movie clip), кнопка (button) и изображение (graphic):
· Изображение (graphic), представляет собой символ, состоящий из единственного кадра. Отсюда следует его статичное название. Если символ действительно представляет собой статичный (не анимирующийся) объект, лучше сделать его изображением (graphic).
· Кнопка (button). Во Flash есть специально приспособленный под функции кнопки вид символа. В нем имеется 4 кадра: Up, Over, Down, Hit, которые содержат следующие состояния кнопок: 
Up - обычное состояние кнопки. 
Over - когда курсор мышки находится над кнопкой. 
Down - когда курсор находится над кнопкой и нажата клавиша мыши. 
Hit - обычное состояние, для кнопки, содержащей ссылку, которую пользователь уже посещал. 
· Анимация (movie clip). Это самый "полноценный" тип символа. В нем может быть любое количество кадров. Символ этого типа может восприниматься как объект типа Movie в ActionScript (это встроенный язык Flash). 
Символы могут быть вложенными вне зависимости от типа. Это является самым главным их достоинством. Например, можно сделать кнопку, которая начнет двигаться, когда над ней будет "пролетать" курсор мыши, просто поместив в кадр Over символ - анимацию. Или на изображение поместить бегущую кошку. Все остальное - дело вашей фантазии. Символы можно создавать как "с нуля" (Insert->New Symbol, Ctrl+F8), так и используя текущее выделение, поместив его сразу в символ (Insert->Convert to Symbol, F8). Второй прием используется гораздо чаще, чем первое, т.к. в этом случае отпадает надобность его позиционировать и изнасть под нужный размер. Для управления символами используется так называемая библиотека (Library). 
 Теперь создаем эталон спутника. Для этого нам потребуется зайти в меню Insert->New Symbol, после чего у нас появится окно –Symbol Properties, в котором нам нужно будет указать Name(имя) и Behavior(поведение) создаваемого символа. Назовем его Спутник, а второе свойство оставим нетронутым. 
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    После этого закрываем это окно, и программа входит в режим редактирования эталона - Спутник. Спутник мы решили изобразить в виде небольшого шара, и для этого нам понадобится воспользоваться инструментом Oval и выставить для этого инструмента Properties (свойства): Fill color (цвет заливки), и Stroke color 
(контура).  Для того чтобы наш спутник выглядел более реально, воспользуемся в Fill color, градиентной заливкой (она обычно используется для имитации 3D-объектов). 
 Выбираем серую градиентную заливку, это самый нижний ряд в палитре цветов заливки вторая по счёту, а  контур делаем бесцветным, т.е. No Сolor в панели инструментов.
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 	Далее в окне Info изменим размер нашего эталона на меньший, в данном случае это 30x30. 
Для того чтобы объектом дальше было легче управлять, центр нарисованного круга должен точно совпадать с точкой привязки в центре сцены. Это можно сделать, выделив объект инструментом Arrow, а потом  либо перетащив объект при помощи мыши, либо при помощи клавиатурных стрелок управления курсором (что позволит более точно перетащить объект к привязке). Эталон спутника создан, переходим к следующему шагу. 

[bookmark: 3._РАБОТА_С_ГРАФИЧЕСКИМИ]2.3. Работа с графическими объектами 
Теперь создаем графический объект – планету и эллиптическую орбиту, в режиме редактирования сцены.
Для этого с начала, в зависимости от размера монитора, нужно изменить масштаб, применённый к сцене, это можно сделать либо посредством вкладки меню View->Magnification->нужный масштаб, либо при помощи ниспадающего меню в нижнем левом углу окна нашего фильма. 
 Планету мы решили представить так же  в виде круга, но уже большего размера, чем спутник,  и без контура и залить градиентной заливкой. 
После того, как мы создали объект планеты, выделив его, изменяем размер и цвет его заливки с серого на синий. Это можно сделать с помощью пункта меню Window->Panels->Fill, а далее в окне Fill и одноимённой вкладке убедимся, что выставлен именно Radial Gradient(радиальный градиент), что будет больше имитировать планету. После чего изменим порог градиента, при помощи маркеров градиента.
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  	 Порог—это точка расположения  сплошного цвета. Промежутки между порогами заполняются цветовым переходом. Пороги представлены в виде маркеров разных цветов, в данном случае белого и чёрного. Сначала мы изменим цвет чёрного маркера на сине-голубой и белого на светло-жёлтый, а потом цветовой переход, работая всё с теми же маркерами. 

[bookmark: 4._СЛОИ_И_АНИМАЦИЯ_С_ДВИЖЕНИЕМ_(MOTION_T]
[bookmark: _Toc432537182]Практическая работа №21
Создание интерактивных фильмов  во  Flash

Цель: научиться создаватть интерактивные фильмы во Flash
Студент должен:
иметь практический опыт:
осуществления навигации по ресурсам, поиска, ввода и передачи данных с помощью технологий и сервисов Интернета (ПО2);
создания и обработки объектов мультимедиа (ПО3);
уметь:
создавать и редактировать объекты мультимедиа (У2);
знать:
назначение, разновидности и функциональные возможности программ для создания объектов мультимедиа (З2).

Слои и анимация с движением (motion tweening) 
 	Теперь приступаем к созданию объекта эллиптической орбиты. Она у нас будет представлена в виде опять таки овала, но уже без заливки и с контуром синего цвета, после чего у нас  получается следующее: 
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После того, как мы создали эллиптическую орбиту, которая расположена по центру нашей планеты, планета разделилась на сектора. Это произошло из-за того, что в технологии-Flash объекты делятся на сектора в точках их пересечения. Данная особенность сначала может показаться неудобной, но в последствии при создании более сложных роликов просто необходима. Нам же для избежания такого разделения планеты и орбиты на сектора нужно всего лишь  сделать двойной щелчок на нужном объекте, а   потом воспользоваться пунктом меню Modify->Group (или комбинацией клавиш Ctrl+G).  Команда Group позволяет сгруппировывать объекты или объекты в одно целое. Для отмены этой команды надо сделать разгруппировку Modify->Ungroup (или комбинацией клавиш Ctrl+Shift+G). 
Сгруппировав отрезки нашей орбиты, вокруг неё появился прямоугольник –это означает что команда группировки выполнена, если бы  этого  не произошло, то пришлось бы повторять операцию. 
Выполнив группировку, выделим орбиту и планету одновременно (стрелкой мыши кликая на объектах, держа нажатой клавишу Shift), и выровним их по центру, открыв для этого окно выравнивания комбинацией клавиш Ctrl+K или выбрав  пункт меню Window->Panels->Align. В этом окне можно увидеть множество различных выравниваний, но нам понадобятся лишь два из них: Align Horizontal Center и Align Vertical Center. 
  
  [image: rolik014_1]

 	Выровняв свои объекты, снимем выделение с планеты, оставив его на орбите,  и на панели инструментов в разделе Options нажав на кнопку Rotate –(Вращение) или же выбрав пункт меню Modify->Transform->Rotate после чего у нас по контуру прямоугольника появляются маркеры. Маркеры - по углам  для вращения,  по центру для наклона. Теперь, используя маркеры по углам,  повернем орбиту примерно на 450, что сделает её более правдоподобной. 
Теперь разгруппируем орбиту и удалим верхнюю её часть, которая находится в области планеты:

 2.4 Слои и анимация с движением. 
В Macromedia Flash все объекты расположены на слоях. 
В компьютерной графике этот инструмент используется очень часто. Представьте, что вы рисуете на прозрачных листах, а потом накладываете их друг на друга. То, что находится на верхних слоях, закрывает содержимое нижних слоев. Слои можно делать невидимыми и/или недоступными, чтобы облегчить редактирование сцены в целом. 
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Во Flash есть пара особенных типов слоев: слои, содержащие траектории движения и слои - маски. Есть достаточно большое количество приемов, в которых используются слои, но во Flash без них просто нельзя обойтись по одной важной причине: в один момент времени для каждого объекта анимации нужен отдельный слой. Объектом анимации считается фигура (shape) или символ (symbol). 
 	На начальном этапе по умолчанию у нас всегда содержится один слой Layer1. Давайте сначала рассмотрим вкратце всю временную шкалу: 
· Маркер - указывает на текущий кадр, отображаемый в окне. При клике на какой-либо кадр, маркер автоматически перемещается на него. 
· Слои - слева находится перечень слоев. Под ним существуют кнопки, позволяющие добавлять и удалять слои. Каждый слой можно сделать невидимым и запретить его для редактирования. 
· Шкала кадров - поле, где вы можете добавлять и удалять простые и ключевые кадры. Если вызвать контекстное меню (нажать на правую клавишу мыши) на каком-либо кадре, вы увидите перечень действий, которые можно совершить. На шкале отображается информация о кадрах, которые являются ключевыми (такие кадры помечаются черными кружочками), содержат действия (буковка "а" над кружочком) или метку (красный флажок, после которого идет название метки). Цвет тоже говорит о типе кадров. Серый цвет - это кадры, которые в точности повторяют ключевой кадр (keyframe). Синеватая или зеленоватая подсветка говорит о том, что кадры сгенерированы Flash (о различиях мы расскажем ниже). И, наконец, белое или "пустое" полосатое пространство говорят о том, что на этих кадрах ничего нет.
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· Кнопки управления тенями - это кнопки, позволяющие отображать соседние кадры как бы через кальку, чтобы видеть разницу между предыдущими и последующими кадрами. Можно задавать глубину такого отображения по обе стороны от маркера. 
 Теперь мы изменим название слоя с Layer1 на Планету, это будет тот слой на котором будет отображаться планета.
 Потом создадим второй слой и назовем его Орбита, после этого на слое Планета выделим орбиту и нажмем Ctrl+X, вырезав орбиту, выделим слой Орбита и выбрав из пункта меню команду Edit ->Paste in Place или Ctrl+Shift+V, вставим орбиту на тоже место, откуда вырезали, но уже на одноимённом слое.
 Фильм в Macromedia Flash представляет собой последовательность кадров, которые выполняются по мере их расположения на шкале времени. Пока анимация не создавалась на шкале времени в каждом слое, есть только один кадр. Кадры обозначены на шкале времени тонкими серыми полосочками. Переходить с кадра на кадр можно воспользовавшись проигрывающей головкой, она отмечена красным цветом на шкале времени над кадрами и пересекает все слои сразу. 
Анимация в Macromedia Flash бывает двух видов покадровая (Frame by Frame) и расчётная (Tween animation). 
          Если в покадровой анимации мы создаём каждый кадр отдельно, то в расчётной мы генерируем промежуточные кадры между начальным кадром и конечным. Расчётная анимация бывает двух видов анимация движения -motion tweening  и анимация форя -shape tweening 
Создадим ещё один слой и назовем его Спутник, затем  откроем панель Библиотеки, и нажав левой кнопкой мыши на символе спутника перетащим его на этот слой, но так, чтобы его центр совпал с концом орбиты, Для того, чтобы это сделать более точно, необходимо отключить слой Планета. После выполненных действий, у нас на слое Спутник, появится ключевой кадр.
Теперь займемся движением спутника по орбите. Выделим спутник,  выберем в пункте меню Window ->Panels ->Frame  или нажмем Ctrl+F, после чего перейдем на вкладку Frame.
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В этой вкладке можно выставить свойства для спутника следующие:
Label-Метка 
Tweening -построение промежуточных отображений.
None – отсутствие анимации.
Motion - При этом способе анимации Flash автоматически строит промежуточные кадры между ключевыми кадрами, заданными вами. Это означает, что вы рисуете объект, потом на другом кадре производите изменения, о которых мы поговорим ниже, и просите Flash рассчитать те кадры, которые лежат между этими двумя ключевыми кадрами. Он выполняет эту работу, и вы получаете плавную анимацию. 
Shape - Скажем, вам нужно, чтобы квадрат плавно превратился в круг, или силуэт кролика плавно перетек в силуэт волка
Scale (on/off) -Масштабировать 
Easing -Ускорение 
Rotate –Вращение и поле ввода для количества оборотов. 
Orient to path (on/off) –Движение по траектории 
Synchronize (on/off) -Синхронизация 
Snap (on/off) –Привязка 
Для спутника метку писать не нужно, выберем motion tweening, ускорение  и вращение оставляем, как было выставлено по умолчанию, и далее лишь выставляем галочки в полях масштабирования, движения по траектории, синхронизации и привязки. Сохраняем изменения Ctrl+S или File ->Save. 
После сделанных изменений для спутника, на всех слоях выделим 66-й кадр и сделаем его ключевым, нажав F6. Если посмотреть теперь на слои, то можно увидеть, что кадры на слоях Орбита и Планета заполнены серым цветом, а Спутника сиреневым со стрелочкой протянутой с 1-го по 66-й. Это означает, что с помощью выставленных только что свойств для спутника,  было сгенерированно его движение. Сейчас мы должны перейти на 66-й кадр на слое Спутник и выделив спутник, переместить его на другой конец орбиты. Ну и самое интересное, проверка созданной анимации! Для этого выберем из пункта меню Window ->Toolbars ->Controller и после появления контроллера нажимаем на клавишу пуск (она изображена в виде стрелочки вправо), чтобы его остановить, нужно нажать на кнопку стоп (она изображена в виде заполненного квадрата). 
Идём дальше, выделим слой Спутник и добавим над ним с помощью такой кнопки на временной шкале [image: rolik021]  или пункта меню Insert ->Motion Guide, направляющий слой. Он будет назван в зависимости от слоя, находящегося под ним, в данном случае Спутник, а обычный слой под ним будет сдвинут немного вправо. Теперь на этот слой скопируем орбиту, так же, как копировали её со слоя Планета на слой Орбита. После этой операции на направляющем слое будут заполнены все кадры, начиная с 1-го по 66-й. Это должно выглядеть следующим образом:

[image: рис. 23]
[bookmark: 5.МАСШТАБИРОВАНИЕ]
  
2.5 Масштабирование 
Чтобы сделать движение  спутника по орбите, следует сделать так, чтобы спутник заходя за Планету исчезал, а когда появлялся, увеличивался в размерах по мере его расположения на орбите. Но так как  при анимации в плеере цикл движений повторяется непрерывно, следует сделать некую приостановку между циклами так, чтобы спутник на некоторое время задержался за планетой, прежде чем снова появится вначале орбиты.  И так во временную шкалу добавим в начало каждого слоя ещё по 4 кадра. Для этого нужно переместить проигрывающую головку в начало шкалы времени и 4 раза нажать на кнопку F5. Таким образом, проигрывающая головка переместилась на отметку 5. Теперь выделив слой Спутник, переведем проигрывающую головку на отметку 5 и нажмем F6, таким образом содержимое нового кадра получает копию содержимого ближнего кадра слева, т.е 1-го ключевого.  Тоже самое делаем с последним кадром, т.е. ставим проигрывающую головку за 5 кадров до последнего и нажимаем F6. Теперь возвращаемся к первому кадру и в окне Info выставляем размер спутника, тоже самое проделываем с последним кадром. Вот что у нас должно было получиться:
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 Так же можно сделать ещё несколько  ключевых кадров для того, чтобы, например, спутник по мере приближения к центру орбиты постепенно увеличивался, а потом снова уменьшался. Мы сделали это  следующим образом: установили проигрывающую головку в ту отметку, где спутник находится почти по центру орбиты и планеты, и вставили новый ключевой кадр, на котором спутник изменяет свой размер с 34 на 60. Потом через 4 кадра вставляли ключевые кадры, сначала справа, уменьшая размер спутника с 60 до 55, потом 55 до 50 и т.д. до тех пор, пока не дошли до 34, а потом так же в обратную сторону.  Вот так:
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[bookmark: 6._АНИМАЦИЯ_ФОРЯ_(SHAPE]2.6 Анимация форя (SHAPE TWEENING) 
На этом шаге мы займемся анимацией форя, для того чтобы создать впечатление вращения планеты вокруг своей оси. В этом случае сама планета передвигаться не будет, а будет изменяться лишь её форма, цвет, расположение или размер.
Начинаем с блокировки всех слоёв, кроме слоя Планеты, для того чтобы случайно не повредить их.  Выделив планету, открываем окно Frame (Ctrl+F) и в одноимённой вкладке выставляем вид анимации форя: Shape Tweening. 
  
[image: rolik034]

  	Далее на шкале времени, на слое Планета появилась стрелочка зелёного цвета вдоль всех кадров. Зелёный цвет означает, что в данном случае применена именно анимация форя. Теперь устанавливаем проигрывающую головку на первый ключевой кадр и выбираем на панели инструментов заливку, внизу в свойствах выбираем Transform Fill [image: rolik036]    . При нажатии левой кнопки мыши на планете, появляется следующее:

  [image: rolik38_1]
 	Этот маркер необходим для передвижения градиента. 
- это для возможности сделать градиент эллиптической Форя.
- масштабирование градиента. 
- поворот градиента.
Теперь для создания визуального эффекта, что планета вращается вокруг своей оси, мы решили воспользоваться самым простым, но очень оригинальным способом. С помощью маркера в центре планеты,  мы модифицируем её градиент в первом и последнем кадре. Итак, мы переводим проигрывающую головку на первый кадр и с помощью маркера выносим градиент за пределы планеты и переносим его влево. Необходимо сделать это так, чтобы его центр соответствовал центру планеты и орбиты, и  чтобы контур градиента и контур планеты были на одной прямое, если включить сетку. 
  
  [image: Ролик 42]
То же самое мы  делаем и для последнего кадра, только градиент переносим уже влево, с теми же условиями что и на предыдущем этапе. 
  [image: Ролик 44]
 
[bookmark: 8._ПУБЛИКАЦИЯ]
2.7. Публикация фильма 
Теперь мы займемся публикацией фильма. Сначала мы выставим нужные нам параметры публикации, для этого воспользуемся пунктом меню File->Publish Settings или комбинацией кнопок клавиатуры Ctrl+Shift+F12, после чего на экране появится следующее окно: 

  [image: rolik048]
Оно содержит три вкладки Formats, Flash, HTML. В первой вкладке указаны типы файлов, которые можно получить после публикации. Мы выберем: .swf, .html, .gif, .exe.  Мы можем снять галочку в строке Use default names, что позволит  сменить имена генерирующихся файлов во время публикации, но нам это неважно поэтому мы оставим её без изменений. 
[image: rolik050]

Теперь перейдем к следующей вкладке – Flash. 
Load Order (порядок загрузки). Этот параметр определяет то, каким образом программа Flash будет отображать первый кадр фильма при его загрузке в приложение или проигрыватель. 
 Bottom Up (снизу вверх) –слои загружаются в возрастающем порядке: сначала самый нижний слой, затем последующий. 
Top Down (сверху вниз) –слои загружаются в порядке убывания. 
Generate size report (Создать отчёт). При установлении этого флажка команда Publish (публиковать) экспортирует файл .txt для просмотра в текстовом приложении. 
Omit Trace actions (отменить действия трассирования). При выборе этого параметра проигрыватель Flash игнорирует любые действия трассировки языка ActionScript. 
Protect from import (Защита от операции импортирования). Этот параметр гарантирует меры безопасности для .SWF-файла  в Internet. При установке этого флажка .SWF-файл нельзя импортировать обратно в авторскую среду редактирования Flash 5 или изменить его каким-либо образом. 
Debugging Permitted (Разрешить отладку). Если этот флажок установлен, вы можете получить доступ к панели Debugger (отладчик) в среде отладки фильма или из Web-браузера, который использует встраиваемый дополнительный модуль Flash Debug Player или соответствующий элемент управления ActiveX. 
Password (Пароль).  Если вы установили флажок Debugging Permitted (Разрешить отладку), то в этом поле можете ввести пароль для получения доступа к панели Debugger (Отладчик). 
JPEG Quality (Качество JPEG). Этот ползунок и расположенное рядом текстовое поле определяют уровень сжатия JPEG, который принадлежит к растровому изображению в фильме Flash. 
Audio Stream (Аудиопоток).  Этот параметр отображает схему текущего сжатия для потокового сжатия. С помощью кнопки Set можно выставить параметры. 
Audio Event (Аудиособытие). Этот параметр такой же, как и предыдущий, но для звуков с синхронизацией типа Event (событие). 
Override sound settings (Перезаписать параметры звука).  Если необходимо применить параметры Audio Event  и Audio Stream 
соответственно для всех потоковых звуков и звуковых событий  и отменить любую уникальную схему сжатия, заданную для конкретного звука в библиотеке Flash, нужно установить этот флажок. 
Version (Версия). Здесь можно выбрать версию программы Flash для сохраняемого SWF-файла. Лучше выставить версию ниже, чтобы можно было смотреть данный фильм во всех версиях, иначе, если просмотреть этот файл, например, в версии 5, а он будет сохранён в версии MX, то возникнут некие проблемы. 
В этой вкладке  оставим всё без изменений, так же как и в следующей вкладке HTML. Теперь выберем пункт меню File ->Publish или Ctrl+F12, после чего произойдёт публикация фильма, и появятся новые файлы с выбранными нами расширениями, т.е.  .swf, .html, .gif, .exe. 

3. Практическое задание
[bookmark: ЗАКЛЮЧЕНИЕ]Создать flash – ролик при помощи ПО Macromedia Flash.
Опубликовать flash – ролик.
Контрольные вопросы:
19. Создание Flash-видео-презентации.
20. Открытие и закрытие изображения. Изменение размеров изображения. 
21. Особенности работы с многослойным изображением. 
22. Особенности работы с графическим планшетом. 
23. Чистка и восстановление деталей изображения с помощью инструмента «штамп». 
24. Приемы сканирования в Photoshop.
25. Понятие разрешающей способности и линеатуры растра. 
26. Звуковые карты.  Их классификация и рабочие характеристики.
27. Типы микрофонов. Основные характеристики микрофонов.

[bookmark: _Toc432537183]	Практическая работа №22
Создание анимации в презентации PowerPoint
Цель: научиться создавать анимаци в презентации PowerPoint
	Студент должен:
иметь практический опыт:
осуществления навигации по ресурсам, поиска, ввода и передачи данных с помощью технологий и сервисов Интернета (ПО2);
создания и обработки объектов мультимедиа (ПО3);
уметь:
создавать и редактировать объекты мультимедиа (У2);
знать:
назначение, разновидности и функциональные возможности программ для создания объектов мультимедиа (З2).

Компьютерная анимация — последовательный показ (слайд-шоу) заранее подготовленных графических файлов, а также компьютерная имитация движения с помощью изменения (и перерисовки) формы объектов или показа последовательных изображений с фазами движения.

	Выполнение практической работы
[image: power point animation]
Разработка презентаций с элементами анимации начинается с создания основной структуры презентации, занесения информации на слайды и изменения дизайна.
[image: Как создавать анимацию в Power Point]
Чтобы после создания основной структуры презентации поместить на слайды информацию, можно использовать графические настройки: отображение сетки.
Отображение сетки включается кнопкой «Отображать сетку» в меню «Упорядочить» на панели инструментов (вкладка «Главная»).
[image: Как создавать анимацию в Power Point]
Для изменения параметров сетки выбираем кнопку «Параметры сетки». Перед пользователем открывается окно редактирования сетки. Графический редактор позволяет отображать основные направляющие слайда для точного выравнивания фигур и объектов.
[image: Как создавать анимацию в Power Point]
Для упрощения редактирования и демонстрирования крупные презентации можно разбивать на тематические разделы. Для того, чтобы создать раздел, который последует за выделенным слайдом, нужно нажать на кнопку «Раздел» на пользовательской панели инструментов. Меняя порядок разделов, можно формировать большую презентацию, состоящую из блоков.
[image: Как создавать анимацию в Power Point]
Завершив работу над содержанием слайдов¸ пользователь переходит к оформлению анимации – способа появления данных на каждом слайде.
Для того, чтобы задать способ анимированного появления объекта, выделяем левой кнопкой мыши объект (в режиме редактирования слайда) и переходим во вкладку «Анимация» на пользовательской панели инструментов.
Анимационный эффект можно выбрать непосредственно в строке или нажав на кнопку «Добавить анимацию».
[image: Как создавать анимацию в Power Point]
Стандартные эффекты («Вылет», «Выцветание» и т.д.) могут быть заданы в индивидуальном порядке для каждого объекта на слайде. При наличии нескольких объектов или заголовков параметры анимации задаются для каждого объекта с присвоением номера. Для задания анимации тексту необходимо выделить текст левой кнопкой мыши.
[image: Как создавать анимацию в Power Point]
Помимо стандартных эффектов анимации пользователь может задать собственную траекторию движения объекта по слайду, выбрав тип анимации «Пользовательская». После нажатия кнопки пользователь самостоятельно задает перемещение объекта, расставляя точки на поле слайда.
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Кроме того, можно менять порядок появления объектов на слайде при помощи меню «Изменить порядок анимации» на панели инструментов. Выделив один из объектов, нажать кнопку «Переместить вперед/назад» для изменения порядкового номера анимации.
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После форматирования анимации пользователь переходит к форматированию способов перехода от слайда к слайду. Во вкладке «Переходы» на панели инструментов можно выбрать тип перехода от текущего (выделенного цветом) к следующему слайду.
На панели инструментов вкладки «Переходы» можно задавать длительность анимированного перехода, тип перехода (кнопка «Параметры эффектов»), задать время, после которого будет сменяться слайд (кнопка «После: 00:00:00»).
Выбранные настройки можно применить ко всем слайдам одновременно (кнопка «Применить ко всем»), или же задавать переход от слайда к слайду вручную.
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После завершения редактирования переходов между слайдами презентацию можно считать практически готовой. Осталось задать параметры показа. Форматирование показа презентации выполняется во вкладке «Показ слайдов» на панели инструментов.
Программа дает возможность пользователю работать в режиме докладчика, когда презентация в полноэкранном виде отображается на одном мониторе, а управляется с другого. Для работы в данном режиме нужно нажать кнопку «Режим докладчика».
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Непосредственно настройка показа выполняется в окне, которое открывается после нажатия кнопки «Настройка презентации». Пользователь может задать цвет указки, время показа слайда и способ показа.
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Для того, чтобы сделать показ автоматическим с определенным временем демонстрирования каждого слайда, можно провести запись показа (кнопка «Запись показа слайдов»).
После чего пользователь просматривает презентацию, перелистывая вручную (по щелчку мыши) элементы, а программа записывает очередность и промежутки времени. В последующем показ презентации будет выполняться в записи.
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Программа Power Point позволяет не только создавать презентации для просмотра на мониторе, но и для печати макетов. Для того, чтобы посмотреть, как будут выглядеть слайды в печатном виде, нужно выбрать вкладку «Вид» на панели инструментов.
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Выбрав на пользовательской панели кнопку «Образец выдач», пользователь переходит в окно редактирования печатного образца.
В данном режиме можно выбрать стиль/цвет печатного фона, количество слайдов на странице и дополнительную печатную информацию (колонтитулы, дата, эффекты).
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[bookmark: _Toc432537196]РАЗДЕЛ 3. ТЕХНОЛОГИИ ОБРАБОТКИ ВИДЕОИНФОРМАЦИИ
Кодирование видеоинформации
Чтобы хранить и обрабатывать видео на компьютере, необходимо закодировать его особым образом. При этом кодирование звукового сопровождения видеоинформации ничем не отличается от кодирования звука, описанного в предыдущей теме. Изображение в видео состоит из отдельных кадров, которые меняются с определенной частотой. Кадр кодируется как обычное растровое изображение, то есть разбивается на множество пикселей. Закодировав отдельные кадры и собрав их вместе, можно описать все видео.
Видеоданные характеризуются частотой кадров и экранным разрешением. Скорость воспроизведения видеосигнала составляет 30 или 25 кадров в секунду, в зависимости от телевизионного стандарта. Наиболее известными из таких стандартов являются: SECAM, принятый в России и Франции, PAL, используемый в Европе, и NTSC, распространенный в Северной Америке и Японии. Разрешение для стандарта NTSC составляет 768 на 484 точек, а для PAL и SECAM – 768 на 576 точек. Не все пиксели используются для хранения видеоинформации. Так, при стандартном разрешении 768 на 576 пикселей, на экране телевизора отображается всего 704 на 540 пикселей. Поэтому для хранения видеоинформации в компьютере или цифровой видеокамере, размер кадра может отличаться от телевизионного. Например, в формате Digital Video или, как его еще называют DV, размер кадра составляет 720 на 576 пикселей. Такое же разрешение имеет кадр стандарта DVD Video. Размер кадра формата Video-CD составляет 352 на 288 пикселей.
В основе кодирования цветного видео лежит известная модель RGB. В телевидении же используется другая модель представления цвета изображения, а именно модель YUV. В такой модели цвет кодируется с помощью яркости Y и двух цветоразностных компонент U и V, определяющих цветность. Цветоразностная компонента образуется путем вычитания из яркостной компоненты красного и зеленого цвета. Обычно используется один байт для каждой компоненты цвета, то есть всего для обозначения цвета используется три байта информации. При этом яркость и сигналы цветности имеют равное число независимых значений. Такая модель имеет обозначение 4:4:4.
Опытным путем было установлено, что человеческий глаз менее чувствителен к цветовым изменениям, чем к яркостным. Без видимой потери качества изображения можно уменьшить количество цветовых оттенков в два раза. Такая модель обозначается как 4:2:2 и принята в телевидении. Для бытового видео допускается еще большее уменьшении размерности цветовых составляющих, до 4:2:0.
Если представить каждый кадр изображения как отдельный рисунок указанного выше размера, то видеоизображение будет занимать очень большой объем, например, одна секунда записи в системе PAL будет занимать 25 Мбайт, а одна минута – уже 1,5 Гбайт. Поэтому на практике используются различные алгоритмы сжатия для уменьшения скорости и объема потока видеоинформации. Если использовать сжатие без потерь, то самые эффективные алгоритмы позволяют уменьшить поток информации не более чем в два раза. Для более существенного снижения объемов видеоинформации используют сжатие с потерями.
Среди алгоритмов с потерями одним из наиболее известных является MotionJPEG или MJPEG. Приставка Motion говорит, что алгоритм JPEG используется для сжатия не одного, а нескольких кадров. При кодировании видео принято, что качеству VHS соответствует кодирование MJPEG с потоком около 2 Мбит/с, S-VHS – 4 Мбит/с.
Свое развитие алгоритм MJPEG получил в алгоритме DV, который обеспечивает лучшее качество при таком же потоке данных. Это объясняется тем, что алгоритм DV использует более гибкую схему компрессии, основанную на адаптивном подборе коэффициента сжатия для различных кадров видео и различных частей одного кадра. Для малоинформативных частей кадра, например, краев изображения, сжатие увеличивается, а для блоков с большим количеством мелких деталей уменьшается.
Еще одним методом сжатия видеосигнала является MPEG. Поскольку видеосигнал транслируется в реальном времени, то нет возможности обработать все кадры одновременно. В алгоритме MPEG запоминается несколько кадров. Основной принцип состоит в предположении того, что соседние кадры мало отличаются друг от друга. Поэтому можно сохранить один кадр, который называют исходным, а затем сохраняются только изменения от исходного кадра, называемые предсказуемыми кадрами. Считается, что за 10-15 кадров картинка изменится настолько, что необходим новый исходный кадр. В результате при использовании MPEG можно добиться уменьшения объема информации более чем в двести раз, хотя это и приводит к некоторой потере качества. В настоящее время используются алгоритм сжатия MPEG-1, разработанный для хранения видео на компакт-дисках с качеством VHS, MPEG-2, используемый в цифровом, спутниковом телевидении и DVD, а также алгоритм MPEG-4, разработанный для передачи информации по компьютерным сетям и широко используемый в цифровых видеокамерах и для домашнего хранения видеофильмов.
Видеооборудование и программы
Обычный компьютер не имеет в своем составе оборудования для ввода и обработки видео. Поэтому на него необходимо устанавливать дополнительное оборудование. Это оборудование может быть самым различным в зависимости от того, какие задачи вы хотите решать. Кроме того, сам компьютер должен отвечать определенным требованиям.
Для захвата и обработки видео особых требований к компьютеру не предъявляется, лишь бы он был оборудован звуковой платой и имел жесткий диск достаточного объема и скорости. Следует учитывать, что один час видео в хорошем качестве будет занимать на диске около 20 Гбайт информации. При этом результат работы программы обработки видео необходимо куда-то сохранять, поэтому необходимый объем должен быть больше в два раза. Что касается скорости работы диска, то лучше выбирать жесткие диски, имеющие скорость вращения 7200 оборотов в минуту и больше. Для того чтобы снимать на видео и обрабатывать полученные фильмы на компьютере, прежде всего, необходима видеокамера. В настоящее время используются три разновидности видеокамер: аналоговые, цифровые и Web-камеры.
В аналоговых видеокамерах изображение хранится на магнитной ленте в видеокассете. При записи на магнитную ленту изображение сохраняется в ней будучи преобразованной в магнитные импульсы. При воспроизведении происходит обратное преобразование магнитных импульсов в изображение. Аналоговыми же видеокамеры называют потому, что записанная магнитная информация по возможности наиболее приближена (является аналогом) к оригиналу. Существует несколько стандартов для записи аналогового видеосигнала: VHS, S-VHS, VHS-compact, Video-8, Hi-8 др. Они различаются параметрами записываемых сигналов, формой и размером видеокассеты. Аналоговые камеры могут содержать встроенные возможности редактирования видео.
[image: Аналоговая видеокамера]
Аналоговая видеокамера
Для того чтобы вводить в компьютер фильмы, снятые аналоговой видеокамерой, понадобится плата оцифровки и ввода видеосигнала. К этой плате подключается аналоговая видеокамера или видеомагнитофон. Основными характеристиками таких плат являются максимальное разрешение изображения (обычно 768 на 576 пикселей), скорость оцифровки (25 или 30 кадров в секунду), пропускная способность (до 8-10 Мбайт/с) и возможность оцифровки звукового сопровождения. Результатом работы этих плат является файл на диске компьютере, содержащий записанное изображение.
Выпускаются также устройства видеозахвата, выполненные в виде отдельных устройств, подключаемых к компьютеру по шине USB. Однако пропускная способность шины USB не достаточна для передачи несжатого видео в компьютер. Поэтому все подобные устройства используют сжатие с потерями.
Популярными аналоговыми видеоустройствами являются телевизионные тюнеры, сочетающие в себе телевизионные приемники и платы ввода изображений в компьютер. Телевизионный тюнер позволяет просматривать на экране компьютера телепередачи или видеофильмы, как на полный экран, так и в окне. При этом тюнер работает как обычный телевизор, только в качестве экрана используется монитор компьютера. Данное устройство представляет собой плату расширения, вставляемую внутрь компьютера и содержащую ряд разъемов. Телевизионный тюнер имеет антенный вход для подключения телевизионной антенны, композитный видеовход для подключения бытовых источников видеосигнала, таких как видеокамера, видеомагнитофон или проигрыватель видеодисков. Некоторые модели тюнеров могут принимать и радиосигнал, позволяя слушать передачи радиостанций на компьютере. Фактически, после установки платы тюнера, компьютер становится и телевизором и радиоприемником.
Web-камеры предназначены для общения в Интернете. Эти камеры не содержат средств хранения видеоинформации, а просто транслируют закодированный видеосигнал в компьютер, где он или отображается на экране, или сохраняется на диске. Соединяются такие камеры с компьютером при помощи интерфейса USB. Возможности Web-камер ограничены, и качество получаемого изображения невысокое.
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Web-камера
С помощью таких камер и соответствующего программного обеспечения можно общаться с другими людьми в Интернете, устраивая видеоконференции. В этом случае все участники видят друг друга в реальном времени. Используя микрофон, колонки и звуковую карту, собеседники могут также слышать друг друга.
Наибольшего качества можно добиться при использовании цифровых видеокамер. Эти видеокамеры записывают изображение в цифровой форме. Внешне они почти не отличаются от аналоговых видеокамер. Однако по принципу действия эти устройства отличаются принципиально.
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Цифровая камера
В качестве носителя информации в этих устройствах выступает специальная кассета с магнитной лентой, набор микросхем памяти, жесткий диск, записываемый компакт-диск или записываемый DVD-диск. То, что информация хранится в цифровом виде, позволяет легко переносить эту информацию в компьютер. Существует несколько форматов хранения цифровой видеоинформации: Digital-8, Mini-DV, MPEG-4.
Выпускаются различные варианты цифровых видеокамер от самых простых до профессиональных. В большинстве камер одной серии возможности хранения видео одинаковы, а камеры различаются наличием дополнительных возможностей. Это может быть размер жидкокристаллического экрана для просмотра снятого материала или наличие карты памяти для хранения цифровых фотографий. Некоторые цифровые видеокамеры можно использовать и как цифровые фотоаппараты.
Большинство цифровых камер подключаются к компьютеру с помощью интерфейса IEEE-1394, также называемый FireWire. Вариантом этого интерфейса является I-Link, разработанный фирмой Sony. Данный интерфейс отсутствует в большинстве современных компьютеров, поэтому чтобы подключить цифровую видеокамеру к компьютеру потребуется дополнительная плата, реализующая этот интерфейс.
Подключив цифровую камеру с помощью такой платы, можно много раз переписывать видео с камеры в компьютер и обратно без потери качества, а также управлять видеокамерой с компьютера. При работе как с цифровой камерой, так и с аналоговыми видеосигналами, следует использовать комбинированные устройства видеозахвата. Такие устройства содержат в своем составе интерфейс FireWire IEEE-1394, а также микросхему оцифровки аналогового видеосигнала в цифровой формат DV. На диск информация в любом случае записывается в формате DV. Устройства могут выпускаться как в виде платы, вставляемой в компьютер, так и в виде внешнего устройства, подключаемого к компьютеру по интерфейсу IEEE-1394.
Естественно, для редактирования на компьютере видео потребуется специальное программное обеспечение. Для простейшей работы можно использовать встроенную в Windows Me и Windows XP программу Windows Movie Maker. Для более сложного видеомонтажа можно воспользоваться программой Ulead Media Studio Pro.
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Ulead Media Studio Pro
Видеомонтаж подразумевает получение видеоизображения с одного или нескольких источников, выполнение над видео различных действий и сохранение полученного в результате монтажа видео. Известны два вида монтажа – монтаж сборкой и монтаж вставкой. Монтаж сборкой используется для создания отредактированного видео путем перезаписи из нескольких других записей или источников видеосигнала. Новая сцена добавляется к концу предыдущей. Монтаж вставкой используется для замены одной сцены на другую.
Различают также линейный и нелинейный видеомонтаж. Особенность линейного видеомонтажа состоит в том, что все операции происходят в реальном времени. Чтобы добиться высокой скорости работы, эффекты и операции осуществляют с помощью специальной аппаратуры. В этом случае роль компьютера сводится к координации работы устройств линейного монтажа и автоматизации рутинной ручной работы.
При использовании нелинейного видеомонтажа все фрагменты исходного видео должны быть введены в компьютер, а затем с помощью специальной программы над этим фрагментом выполняются различные операции. При этом в зависимости от используемой программы можно выполнить практически любые преобразования над исходными фрагментами видео. В результате полученное видео можно сохранить на диске компьютера, записать на видеомагнитофон или цифровую камеру.
В настоящее время наиболее распространен нелинейный видеомонтаж. Для нелинейного видеомонтажа используются специальные программы, среди которых упомянутая выше программа Ulead Media Studio Pro, а также программа Adobe Premiere. Эти программы являются универсальными и позволяют оцифровывать видеосигнал, производить его обработку, а также кодировать полученное изображение в различные форматы.
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Adobe Premiere
Кроме универсальных программ существует большое количество специализированных, которые решают отдельные задачи.
Любой созданный фильм можно просмотреть не только на экране компьютерного монитора. При наличии платы оцифровки видео, имеющей видеовыход, или видеоадаптера с видеовыходом, можно подключить телевизор и просматривать на нем изображения. Также можно подключить обычный видеомагнитофон, и записать фильм на кассету.
При работе с цифровой видеокамерой можно не только получить с нее отснятый материал, но и записать отредактированный фильм обратно. В дальнейшем имеется возможность просматривать фильм на обычном телевизоре, подключив к нему цифровую видеокамеру. Достоинством данного способа работы является отсутствие дополнительных искажений, вносимых при преобразовании видеоматериала из цифровой формы в аналоговую. Видеофильм будет храниться в цифровом формате.
Существует ряд программ, позволяющих записать видеоинформацию на заготовку CD или DVD. Одной из таких программ является программа Ulead DVD Workshop. Лучше всего записывать видеоинформацию на DVD-диск. Однако можно использовать и устройство CD-RW для записи видео на компакт-диск. Хотя на таком диске поместится не слишком длинный фильм, себестоимость хранения видео будет чрезвычайно низкой, а качество записи достаточно высоким. При этом современные проигрыватели DVD могут воспроизводить как записываемые диски CD-R, так и перезаписываемые диски CD-RW.
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